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Chapter 1
Introduction to JMP Genomics

Welcome to JMP Genomics, a powerful desktop software system for integrated statistical analysis of 
genetic marker, microarray, and spectral (proteomics and metabolomics, for example) data. JMP 
Genomics consists of more than 100 independent analytical procedures (APs). The purpose of this 
manual is to provide you with informative examples of how to use JMP Genomics to extract the maxi-
mum amount of useful information from genomics data. You should be familiar with the terminology 
and technology associated with modern genomics analyses and standard JMP functionality. The JMP 
Introductory Guide provides information about getting started with JMP.

This chapter provides an overview of the primary functional aspects of the JMP Genomics system, 
descriptions of some important differences between standard JMP functionality and JMP Genomics 
functionality, and descriptions of the included sample data sets.

About this Documentation
The JMP Genomics documentation is presented as a series of individual manuals. Each manual is char-
acterized by one or more specific themes. This general theme of each book is described, as follows:

I. Getting Started with JMP Genomics
This is the manual that you are currently reading. It lists installation instructions and require-
ments, provides a brief introduction to JMP Genomics and this documentation. This manual also 
provides a trouble shooting guide, various appendices, a comprehensive glossary, index and a com-
plete reference list for all of the manuals. 
Depending on the nature of your experiments and the types of analysis that you want to perform, 
this manual might be the only one you refer to on a regular basis.

II. Importing Data
This manual is divided into two parts. The first part, Experimental Design, describes how to use 
JMPs DOE functions to design your experiment and generate an experimental design file, which 
is the first step in your analysis. The second part, Importing Data into JMP Genomics provides de-
tailed descriptions of the different types of data sets used by JMP Genomics and how to import 
data from different sources .

III. Workflows 
This manual provides detailed descriptions and instructions for setting up and using the basic 
JMP Genomics workflows

IV. Genetic Analyses
This manual provides detailed descriptions for manipulating genetic data sets, determining spe-
cific marker statistics, carrying out various association tests, assessing linkage, mapping quantita-
tive trait loci, and performing haplotype analyses.
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V. Copy Number Analysis
This manual provides detailed descriptions for normalizing and analyzing copy number data.

VI. Spectral Preprocessing and Analysis
This manual describes the JMP Genomics processes that are useful for analyzing two dimensional 
and three-dimensional spectra.

VII. Expression Analysis
This manual lists and describes a multitude of procedures for performing quality control on your 
data, normalizing it, fitting statistical models to the observations and comparing the aggregated 
results.

VIII. Pattern Discovery and Predictive Modeling
This first part of this manual lists and describes a multitude of procedures for discovering patterns 
in your data. The second part of this manual details a number of different predictive models as 
well as procedures for comparing the relative efficacy of the different models with your data.

IX. Further Analysis 
This manual provides detailed descriptions for examining and characterizing the statistical signif-
icance of your data and for incorporating biological meaning with your statistical results.

X. Utilities
This manual provides you with detailed descriptions of the many tools in JMP Genomics designed 
to help you view and manipulate your data and transform your data sets into formats appropriate 
for specific analyses. 

XI. The JMP Genomics Programming Guide
This manual provides an introduction to building and programming your own analytical process-
es. These processes can be added to the JMP Genomics menu.

About Each Chapter
The manuals are divided into many short chapters. Each chapter corresponds to a separate AP. The 
manuals are organized so that chapters generally occur in the same order in which the APs appear in the 
JMP Genomics menu. 

Chapters are divided into the following sections:

What does it do?
This section provides a brief overview of the AP, telling what the AP does and when and why you 
might use it.

What do I need?
This section describes any requirements for running the AP. It lists the type of input data sets need-
ed, the format of those data sets, and the type of information that must be contained within them. 
Any prerequisite modifications to the data sets are described here. Additional requirements (such 
as accounts with online databases, and so on) are also described.

The Dialog
This section describes the dialog for the AP. All tabs are illustrated. All inputs (buttons, fields, text 
boxes, check boxes, and so on) and their purposes are described and defined.
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Example
This section describes an example analysis using the AP. The input data is described. In most cases 
The input data sets are included with JMP Genomics so you can follow along with the example. 
Any recoding, prerequisite analysis, filtering, or other manipulations of the input data are fully de-
scribed or referenced. In those case where you might need to download input data sets or other 
information from other providers, the location and procedure for accessing the data is described. 
Finally, all input settings are illustrated and described.

Results
The data sets, graphics and other output of the example analysis are illustrated and described. If 
this step is intermediate in an analysis, subsequent APs are suggested.

The text conventions illustrated in Table 1.1 are used throughout this manual. 

Genomics Main Menu
JMP Genomics is a fully functional version of JMP plus a collection of analytical process dialogs in the 
Genomics main menu (Figure 1.1). It provides access to more than 100 analytical processes.

Table 1.1 Text Conventions.

Symbol/Font/Style Used to designate:

Instruction or task to be 
performed

A > B > C Navigation path from A 
to B to C, used for paths 

through nested directories

A > B > C Navigation path from A 
to B to C, used for paths 
through nested menus

Choose or Run Buttons or Commands

General or Options Names of data tables, col-
umn headings, and other 
text generated by JMP are 

set in a different font

General or Options Text to be typed by the 
user.
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Figure 1.1 The JMP Genomics main menu is organized into submenus.

The Genomics Starter
A new feature in JMP Genomics 5.0 is the Genomics Starter window (Figure 1.2). This dialog enables 
you to quickly view and access all JMP Genomics input engines, workflows, and analytical processes.

Figure 1.2 The Genomics Starter dialog

To use the Genomics Starter, first select one of the items in the Click a Category field.
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When you select a category, the subcategories that it contains are displayed in the Click a Subcategory 
field.

Select one of the items in the Click a Category field.

When you select a subcategory, specific buttons for the processes listed in that subcategory become 
available.

Click on one of the buttons to open the desired process.

Some Important Differences between JMP and JMP Genomics

JMP Genomics Dialogs

JMP Genomics dialogs function differently from standard JMP dialogs. Standard JMP dialogs invoke 
calculations in compiled code, whereas JMP Genomics dialogs generate a SAS program (with suffix 
.sas), execute it in the background, and then return results. The results typically consist of SAS data 
sets (also known as SAS data tables, with suffix .sas7bdat) along with a JMP scripting language file 
(with suffix .jsl) that automatically invokes standard JMP platforms. 

An important distinction of most JMP Genomics dialogs is that they do not process open JMP data 
tables. Instead, they prompt you to specify one or more SAS data sets that have been created and saved 
in your file system. This characteristic enables you to work with very large data sets without having to 
open them as JMP data tables and to specify multiple SAS data sets in one process.

The creation and use of JMP Genomics data sets is described more fully in Data Sets Used by JMP 
Genomics.

Deciding Which Processes to Run
An initial challenge in using JMP Genomics is deciding which processes to run and in what order they 
should be run.   The software does not provide detailed guidance on constructing a workflow, and there 
are a wide variety of possible workflow combinations depending on your discovery objectives.

The Genomics menu organizes the JMP Genomics processes into groups. The groups are organized in 
an order that is typically used by bioinformaticians, statisticians, and data analysts. However, you are 
free to rearrange the menus to your liking. Refer to the Programming Guide for details about customiz-
ing menus.

JMP Genomic processes are modular, so they can be run in any order. Over time, you develop expertise 
with the system and form favorite workflows. The sample case studies, outlined in the JMP Genomics 
User Guide, illustrate some typical, frequently used workflows.
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Running a Process
To run a JMP Genomics process, select the process from one of the JMP Genomics menus, specify the 
parameters on all tabbed panes in the process dialog, and then click Run. The following example, 
which invokes the ArrayTrack Input Engine, illustrates a typical JMP Genomics process.

Select Genomics > Import > Other Expression > ArrayTrack. The dialog shown in Figure 1.3 
opens:

Figure 1.3 A typical JMP Genomics dialog

Each dialog has three main sections: a description box, one or more tabbed parameter panes, and func-
tional buttons (illustrated in Figure 1.3). The description box on the top of the dialog describes the 
purpose of the process. The tabbed panes are the main area to specify input parameters.

The eight functional buttons, common to all of the JMP Genomics dialogs, are described in Table 1.2

Table 1.2 Functional Buttons.

Functional Button Used to:

Run the process using the specified 
parameters

Save the specified parameters

Load selected, saved parameters into 
the dialoga

}

}

Description

Functional

Parameter
Panes

Buttons
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Chapter 1 Introduction to JMP Genomics 9

Use these buttons to load, save, or clear specified parameters, run the process using the specified param-
eters, or apply those parameters to other JMP Genomics processes.

Note: Clicking  opens the JMP Genomics User Guide to the title page of the specific volume 
containing information about the dialog that is open and in focus. You must still scroll down from the 
title page to the specific chapter describing the AP.

There is a defined order to the specification of some parameters. Such parameters are disabled and 
grayed out until their dependency requirements are fulfilled. Many processes contain multiple tabbed 
panes with numerous optional parameters. As you develop expertise with particular processes, be sure 
to investigate the often rich collection of parameters available.

Click  to the right of any parameter entry field to obtain help about its specification.

The General tab for each dialog typically contains the most important parameters for the process. For 
example, most processes require specific types of input files or data sets and an output folder. For our 
example, we want to open the AT_exp2.txt file. This Experimental Design File, which contains informa-
tion about the experiment, is needed to import raw data into JMP Genomics.

Click Choose (circled in Figure 1.4)

Apply the specified parameters as 
default settings to all relevant JMP 

Genomic dialogs

Save the specified parameters as the 
default setting.

Clear all the parameter settings and 
return the dialog to its default state

Open the specific volume of the JMP 
Genomics User Guide that contains 

information about the AP.

Cancel the process and close the dialog

a. You can also load settings using the File > Load Genomics
Settings command.

Table 1.2 Functional Buttons.

Functional Button Used to:
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Figure 1.4 Click Choose to select a file or folder.

When you installed JMP Genomics, a folder named Sample Data was also installed. Navigate to 
this folder and then to a file named AT_exp2.txt by following the path Sample Data > Microarray > 
ArrayTrack.

Click on the AT_exp2.txt file.

Click Open to select the file (circled in Figure 1.5)

Figure 1.5 Click Open to select the file.

The file is added to the dialog, as shown in Figure 1.6.
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Figure 1.6 The Experimental Design File has been specified.

Our next step is to select the folder containing the raw data files.

Click Choose (circled in Figure 1.7).

Figure 1.7 Click Choose to select a file or folder.

Navigate to the Sample Data folder and then to a folder named ArrayTrack by following the path 
Sample Data > Microarray > ArrayTrack.

Click OK (circled in Figure 1.8) at the bottom of the Browse for Folder window.
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Figure 1.8 Selecting the ArrayTrack folder

The next step is to choose a folder in which to place and store output. You can choose any folder that 
you like. For this example, select the ProcessResults folder that came with JMP Genomics.

Repeat the selection process to specify the output folder.

The completed dialog is shown in Figure 1.9.

Figure 1.9 The completed ArrayTrack Input Engine dialog

Once you have specified the parameters for a process, click Save to save the parameters for later 
recall, if needed.

Click Run to run the process.

JMP Genomics dialogs generate and run a SAS program each time you click Run. Depending on the 
size of your data sets and capacities of your computer, some analyses can take several minutes or, for 
very large and complex runs, several hours. While a program is running, the message SAS Running 
Processes window is displayed (Figure 1.10).
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Figure 1.10 Display during analysis

While a process is running, it is a good idea to monitor progress using an application that displays sta-
tistics such as CPU, memory, and disk usage, like the Windows Task Manager. This can be informative 
for troubleshooting a hung process.

You can only run one process at a time. If you attempt to run a second process while another one is 
running, you are prompted to either disconnect from SAS and stop the current process, to view the cur-
rent SAS log, or to wait until it completes.

The location of each SAS data set generated by your analysis is listed in a new window (shown in 
Figure 1.11). You can view each of the data sets by clicking Open.

Figure 1.11 The SAS Message generated by our analysis
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Tabbed Reports
If the output from a process includes graphs and charts in addition to the data sets, these output are 
organized and accessed through a tabbed report (Figure 1.12). 

Figure 1.12 A tabbed report generated by the ANOVA process

Plots and relevant data are accessed using the drop-down menus in the Tabs pane (Figure 1.13).
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Figure 1.13 The Tabs pane (left). Output can be accessed using drop-down menus (right).

Data sets can be accessed from the Output SAS Data Sets pane (Figure 1.14).

Figure 1.14 The Output SAS Data Sets pane

Finally, you can drill-down into your data or launch follow-up processes from the Action Buttons 
(Figure 1.15) or Launch Follow-Up Processes (not shown) panes.

Figure 1.15 The Action Buttons pane

Stopping a Process
To stop any JMP Genomics process currently running, click Run a second time to bring up a 
Warning:SAS is Running window. Click Stop to terminate the process.
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Note: You cannot use the Stop option to stop either the Affymetrix Tiling CEL Input Engine or the 
Affymetrix Tiling Bar Input Engine. To stop these processes, simultaneously click <Ctrl>, <Alt>, and 
<Delete> to open the Windows Security window. Click Task Manager, click Processes, highlight 
the TilingReader.exe routine and click End Process.

Saving and Loading Settings
JMP Genomics dialogs enable you to save and load parameter settings. This enables you to save, recall, 
modify and exchange analyses without having to re-enter specifications each time your run a process. 
You can save and load settings using the Save and Load buttons at the bottom of each dialog. Most of 
the processes in JMP Genomics come with one or more example settings that use the example data sets 
that come with the system. A good way to learn about a new process is to load one of the example set-
tings, study its parameter values, run the process, and explore the results.

SAS Variable Names and Labels
Each variable/column in a SAS data set must have a unique name. SAS variable names must conform to 
the following conventions:

1 The first character must be a letter (A, B, C, …) or underscore (_).

2 Subsequent characters can be letters, numeric digits (0,1,2 …) or underscores (_).

3 Blank spaces are not allowed.

4 Special characters, except for underscore, are not allowed.

5 Names must not exceed 32 characters.

SAS variable names are not case-sensitive.

SAS variables can be either character or numeric. In either case, a fixed length is assigned to store each 
observation of that variable.

Optionally, SAS variables can have a label. Labels have much less restrictive creation rules. For example, 
SAS labels can be up to 256 characters in length and can contain blanks and special characters. When 
JMP opens a SAS data set, it reads the labels (when they exist) and uses them as JMP data table column 
names.

If you want information about the variable names and labels for a SAS data set, run the Column Con-
tents process under the Data Set Utilities menu. There are other processes available for changing SAS 
variable names, labels, and lengths.
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Sample Case Studies
The following data sets, included with JMP Genomics, which are detailed below, enable you to work 
through most of the analytical processes in JMP Genomics. In addition to the data sets, each case study 
includes experimental design files and other needed files. These case studies are referred to throughout 
this manual. 

Drosophila Aging Experimental Data

This data set represents a small subset of the Drosophila aging experiment data from (Jin, Riley et al. 
2001). The experiment consisted of 24 two-color cDNA microarrays, 6 for each experimental combi-
nation of 2 lines (Oregon and Samarkand), 2 sexes (Female and Male), and 2 ages (1 week and 6 
weeks). The Cy3 and Cy5 dyes were flipped for two of the 6 replicates for each genotype and sex combi-
nation. The design is a split-plot, with Age and Dye as subplot factors, and Line and Sex as whole-plot 
factors.   A total of 4256 clones were spotted on the arrays, but this example uses a subset containing 
100 randomly selected genes from the original data set.

Affymetrix Latin Square Data

The spike-in data set used in this example was originally generated by Affymetrix Corporation to 
develop and validate their U95A GeneChip and Microarray Suite (MAS) 5.0 algorithm over a range of 
known concentrations (Affymetrix, 2001). The experiment consists of 59 arrays. There are 14 experi-
mental groups, designated with letters, a, b, c, d, e, f, g, h, i, j, k, l, m, and q. (Group m and group q 
each have 4 within-chip replicates, group m replicates were originally designated n, o, and p and group 
q replicates were originally designated r, s, and t, The extra letters are not needed because they are repli-
cates of m and q, respectively.)

Each experiment was repeated in triplicate using Affymetrix chips cut from different wafers. The last 
four digits of the wafer numbers are 1521, 1532 and 2353. Wafer 2353, chip c was defective so is not 
included in the data set. For wafers 1521 and 1532, 20 .cel files were generated, and for wafer 2353, 19 
.cel files were generated. Each group contains a pool of non-specific RNA as well as a set of 14 distinct 
human transcripts spiked in at known concentrations of 0, 0.25, 0.5, 1, 2, 4, 8, 16, 32, 64, 128, 256, 
512 and 1024 pM.

Prostate Cancer Biomarkers

This data set was obtained by surface-enhanced laser desorption/ionization (SELDI). This method 
allows an investigator to detect and resolve multiple proteins bound to protein chip arrays (Merchant 
and Weinberger 2000). This approach was used by Qu, et al. (2002) to discriminate prostate cancer 
from non-prostate cancer patients. The promise of this approach is that a panel of multiple biomarkers 
can be used to distinguish important phenotypes such as cancer status. However, great care must be 
taken to pre-process and analyze the data appropriately to ensure generalizability of results.

The example data set consists of serum samples collected from 165 men, 84 of whom had prostate can-
cer. The remaining 81 men are considered to be controls. The primary goal is to determine differences 
in protein expression between these groups.
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Sample Genetic Marker Data

These data are computer-simulated. The data are in wide form, with the 1000 rows corresponding to 
individuals and 130 columns corresponding to various data on these individuals. These data contain 
family, genotype, and phenotype information. The disease column contains the binary trait of primary 
interest, with 1 indicating individuals affected with the disease and 0 indicating unaffected individuals. 
There are also four quantitative traits and sixty markers, with two possible alleles (designated 1 and 2), 
per marker, for each individual. The marker data occur in pairs, so that the genotype at the first marker 
comprises columns ma1 and ma2, ma3 and ma4 the second marker genotype, and so on.   The analy-
ses performed on this data set are aiming to locate the gene or genes that affect susceptibility to this dis-
ease.

Accompanying this data set is a map data set that provides information about the 60 markers, which are 
spread across two hypothetical candidate gene regions. The variable representing on which candidate 
gene the marker resides can be used to group analyses, and the Location variable is useful for accurately 
displaying distances in base pairs between markers along the x-axis of plots containing various associa-
tion p-values.

Affected Sib-Pair (ASP) Data

Two hundred families, each containing an affected sib-pair and the siblings' parents, were genotyped at 
20 markers from a single chromosome in simulated data provided by Gonçalo Abecasis at the Univer-
sity of Michigan Center for Statistical Genetics. MERLIN was used to estimate identical-by-descent 
(IBD) allele-sharing probabilities at these markers for all pairs of related individuals.   The 400 off-
spring are also measured for a quantitative trait of interest.

Additional Data Sets

Some of the examples discussed in this manual make use of data sets, not included with JMP Genom-
ics, nor described here. Where applicable, these additional data sets are described in relevant chapters. 
We have tried, wherever possible, to use publicly available data sets and, as part of the description, have 
included instructions on where and how you can obtain these data.



Chapter 2
Using JMP to Design New Experiments

JMP offers a wide range of Design of Experiments (DOE) functionality, including classical designs. 
Most of these functions are grouped under the DOE menu (Figure 2.1).

Figure 2.1 JMP’s DOE menu

This chapter guides you through some of the features in JMP that plan efficient experiments. For scien-
tific discovery and genomics purposes, we focus only on the first item in this menu: Custom Design 
(Figure 2.1). Refer to the JMP Design of Experiment Guide for in-depth details and background on all 
items in this menu.

Note: Some of the terminology in the JMP Design of Experiments guide is derived from the statistical 
and engineering literature, which chronicles a long, rich, and successful history of highly efficient 
experimental designs. Many of the best designs are not widely known or utilized in genomics research, 
but JMP enables you to rapidly find and customize them for your laboratory's needs.

The examples illustrated on the following pages demonstrate how easy it is to use JMP’s DOE func-
tions in planning gene expression and other studies.

Example 1: A Two-Way Design for Single Channel Instrumenta-
tion

This example uses 12 biological samples to study the effects of a chemical agent versus a chemical con-
trol. The study examines the expression of a large set of genes, proteins, or metabolites at 1 hour, 6 
hours, and 24 hours after dosing the samples with the chemical. Because of the destructive nature of the 
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expression protocol, each sample can be treated with only one chemical and observed at only one time. 
Expression is measured with a single-channel instrument, which excludes two-channel microarrays, 
considered later in this chapter. A standard two-way design is appropriate in this case. 

The JMP Custom Design platform allows you to interactively create designs of any complexity, but 
let's begin with this simple case.

Select DOE > Custom Design.

The dialog shown in Figure 2.2 opens.

Figure 2.2 JMP’s DOE-Custom Design dialog

The two main fields of the DOE-Custom Design dialog are Responses and Factors. These fields allow 
entry of responses and factors specific to your experiment. 

Responses are the numerical measurements taken during the experiment. In Genomics research, thou-
sands of responses are collected simultaneously, so JMP Genomics has special conventions for loading 
large response data files. These conventions are explained later. 

For now, make no changes to the Response field.

Factors are the variables that are controlled during the experiment. They are the effects of interest. For 
our two-way experiment, we have two factors: Treatment and Time. Treatment has two levels: Agent 
and Control. Time has three levels: 1h, 6h and 24h.

To add the first factor to the design, complete the following steps:

Select Add Factor > Categorical > 2 Level using the drop-down menu, as shown in Figure 2.3.
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Figure 2.3 Adding a two level categorical factor.

A two-level categorical factor, termed X1, is added (Figure 2.4). 

Figure 2.4 The first factor has been added to the design.

To specify the X1 factor as Treatment, complete the following steps:

Double-click on X1 and type Treatment, as shown in Figure 2.4.

Double-click on L1 (under Values) and type Agent.

Double-click on L2 (under Values) and type Control.

To add the second factor to the design, complete the following steps:

Select Add Factor > Categorical > 3 Level using the drop-down menu.

A three-level categorical factor, termed X2, is added. To specify the X2 factor as Time, complete the fol-
lowing steps:

Double-click on X2 and type Time.

Double-click on L1 (under Values) and type 01h.

Double-click on L2 (under Values) and type 06h.

Double-click on L3 (under Values) and type 24h.

Tip: Using zero-padding to code numerically-based values with varying lengths ensures alphabetical 
sorting order matches numerical order during later analytical processing in SAS.
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Note: You could optionally define Time as a Continuous factor if you plan to directly model linear or 
quadratic trends over time. For this example, we define Time as categorical in order to allow each time 
level to have an arbitrary mean response.

The completed Factors field is shown in Figure 2.5.

Figure 2.5 The completed Factors field

Click Continue to proceed to the next design step.

The updated DOE-Custom Design dialog is shown in Figure 2.6.

Figure 2.6 JMP's DOE-Custom Design Dialog window (part II)

There are no constraints to be defined

Skip the Define Factor Constraints section. 



2
U

s
in

g
 J

M
P

 to
 D

e
s
ig

n
 N

e
w

 E
x
p

e
rim

e
n

ts
Chapter 2 Using JMP to Design New Experiments 23

The Model section allows specification of the design that enables estimation of interactions between 
individual factors, such as Treatment and Time. 

Examine the Design Generation section at the bottom of the dialog shown in Figure 2.6.

In the current design, with no interaction terms specified, the default number of runs is set to 6. To 
specify the interaction of factors in the design, complete the following step:

Select Interactions > 2nd using the drop-down menu as shown in Figure 2.7.

Figure 2.7 Adding two-level interactions

Examine the Model section of the dialog.

A Treatment*Time row has been added to the model, as shown in Figure 2.8.

Figure 2.8 The completed model

The default number of runs listed in the Design Generation section (Figure 2.9) has changed to 12. 

Figure 2.9 The updated Design Generation section

Note: A run is one specific combination of factors applied to obtain one set of responses.

Since there are 12 samples budgeted for the runs, leave this field as is and click Make Design to 
generate the design shown in Figure 2.10.
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Figure 2.10 JMP's DOE-Custom Design Dialog window (part III)

Examine the DOE-Custom Design Dialog window shown in Figure 2.10.

The Design section sequentially lists the 12 runs. 

Whenever possible, it is always a good idea to randomize the order in which you collect experimental 
data. This helps avoid any unwanted trends that may creep into the data over time. If you are unable to 
randomize the order of one or more factors, you should consider more complex designs such as Ran-
domized Block or Split-Plot designs, described later in this chapter. To do this randomization, complete 
the following steps:

Make sure that Randomize is selected in the Run Order drop-down menu in the Output Options 
box (Figure 2.11).

Figure 2.11 The Output Options box

Leave the number of replicates set to 0 because all 12 available samples are used in the design.

Click Make Table.

The Experimental Design table shown in Figure 2.12 is generated.
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Figure 2.12 The Experimental Design table

The treatment to which each biological sample is subjected and the time at which each sample is 
observed are both listed in Figure 2.12. Note that the run order (1-12) may be different than 
Figure 2.12 because of the random number generator used to generate this design. 

This is an example of a completely randomized design. The levels of both Treatment and Time are 
arranged in a random order.

When collecting expression data on only one gene, protein, or metabolite, simply enter the data in the 
Y column and then analyze them directly in JMP using any number of different methods.   But to work 
with thousands of expression measurements simultaneously, JMP Genomics requires you to construct a 
table like this one as a way to link the experimental design information to a collection of raw response 
data files, each of which contains thousands of measurements. Construction of this table, known as an 
Experimental Design File, requires adding two columns to this table, called File and Array, that are 
described more fully in The Experimental Design File (EDF). The File column lists the names of the raw 
data files containing the expression measurements corresponding to the factor levels for the run in its 
same row. The Array column contains a unique index for each array in the experiment. 

For now, the table is ready to use in the lab to run the design in the random order specified.

Example 2: Incorporating Blocking Factors in a Designed 
Experiment

Experimental designs are often difficult to conduct in a completely randomized fashion because of the 
presence of one or more additional factors that can induce correlation in the observed responses.   In 
these situations you should define one or more blocking factors to better control unwanted experimen-
tal variation. Examples of blocking factors include: batch, animal, day of processing, technology lot 
number, machine, location, laboratory, technician, or operator. Blocking factors are typically consid-
ered random because they can be viewed as arising from a population of effects having a probability dis-
tribution, usually a normal distribution.

To continue the two-way design example, illustrated above, suppose that the 12 samples are not totally 
independent, but that 3 samples each were taken from 4 distinct batches. The batches could consist of 
any number of things, including the day of initial sample collection or the mode of processing them. In 
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this case, it is important to control for the effect of batches on the experimental outcomes. To do this, 
add Batch as a blocking factor to the design. Defining such a blocking factor lets you model a correla-
tion between samples from the same batch and provides a more accurate assessment of true 
batch-to-batch variability. Ignoring the batch effect when it is significant leads to biased conclusions 
about expression differences.

To add Batch to the previous design, complete the following steps:

Select DOE > Custom Design to begin a new design.

Define Treatment and Time factors, as previously described. 

Click Factor > Blocking > 3 runs per block. Double-click on X3 and change it to Batch. 

The Factors section should now appear as shown in Figure 2.13.

Figure 2.13 Design with a blocking factor

Click Continue to specify which terms need to be modeled.

Click Interactions > 2nd.

Click Continue in any message windows.

Click Make Design to generate the Custom Design shown in Figure 2.14.
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Figure 2.14 Custom Design dialog with 1 blocking factor

Examine the Custom Design dialog shown in Figure 2.14.

Note that the Batch factor has four levels, with three runs for each level.

Click Make Table to generate the Experimental Design table shown in Figure 2.15.

Figure 2.15 Experimental Design table (with 1 blocking factor)

This is an example of an Incomplete Block Design. The blocks corresponding to Batch are incomplete 
because not all combinations of treatment and time are observed within a block; however, there is a 
form of partial balance in the experiment, because each unique combination of treatment and time is 
observed exactly twice across the whole experiment. 
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Note: Good designs often have some form of balance in terms of number of treatment combinations 
observed. Balancing the number of factor levels helps break confounding among factors and ensures 
approximately equal information gain on all relevant differences.

Example 3: Generating a Split-Plot Design
Continuing our two-way experiment example with factors Treatment and Time on a single-channel 
instrument, suppose that instead of the need for the batch blocking factor, the actual constraint is that 
samples need to be processed immediately after collection at the 1 hour, 6 hour, and 24 hour time 
points. In other words, it is not feasible to conduct the experimental runs in a completely randomized 
fashion; rather, they must be processed in time order. 

This is a situation calling for a Split-Plot Design, in which certain factors are easy to change in the lab 
and others are hard to change. You can easily generate a split-plot design in JMP DOE by changing val-
ues in the Changes column in the Factors section.

Select DOE > Custom Design to begin a new design.

Define Treatment and Time factors, as previously described. 

In the Changes column, click Easy in the Time row.

Select Hard from the menu that appears, as shown in Figure 2.16.

Figure 2.16 Changing Time from Easy to Hard

Click Continue to define the model.

Click Interactions > 2nd in the Model section.

Click Make Design to proceed to the next step (shown in Figure 2.17).
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Figure 2.17 DOE-Custom Design dialog (split-plot design)

Notice the automatic creation of the Whole Plots column in the Design section. 

Note: The term Whole Plot derives from agricultural field research where split-plot designs were origi-
nally popularized. Imagine a two-way design in a field trial in which the effects of plant variety and dif-
ferent fertilizers are to be studied.   The fertilizers can only be applied to large sections of the field via 
large machinery or airplanes, but varieties can be planted in smaller sections.   The split-plot design 
consists of dividing the field into fertilizer-level sections called Whole Plots, and the varieties are planted 
in subplots within each whole plot. 

There are six whole plots in this design. Note that levels of Time are constant within any particular 
whole plot. In contrast, the Agent and Control levels of Treatment change within whole plots. Treat-
ment is known as a subplot factor, and Time as a whole-plot factor. By their nature, split-plot designs pro-
vide more precision in estimating effects of subplot factors than they do for effects of whole-plot 
factors. This is perhaps intuitive given the constraints placed on the whole-plot factors.

Many experimenters employ split-plot designs without realizing it when they process samples in a 
grouped order, but then analyze the data as if they were completely randomized. This practice can lead 
to badly biased conclusions, especially when the whole-plot effect is substantial. The appropriate way to 
analyze a split-plot design involves specifying whole-plots as a random effect in the analysis, thereby 
modeling a correlation among measurements taken within the same whole plot.
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Example 4: Split-plot Design for Two-Channel Microarrays
Two-channel microarrays are characterized by the fact that two measurements for each gene are 
obtained from each microarray. This is because two different samples are tagged with different dyes, 
competitively hybridized to one array, and then measured under two different laser frequencies. This 
technology therefore offers an additional layer of complexity for experimental design beyond the 
one-channel designs described previously.

Several papers have discussed different two-channel design options in detail, including Kerr and 
Churchill (2001) and Dobbin and Simon (2002). Arguably the most popular design is the Reference 
Sample Design, in which a common reference sample (typically a pool of samples that is not of direct 
experimental interest) is tagged with one dye and hybridized on every array, while the various treated 
samples are tagged with the other dye.   This design is easy to set up and effectively reduces design con-
siderations to the single channel that is changing.

However, the reference sample design can be two to four times less efficient than designs that hybridize 
samples of interest directly together on microarrays. The keys to higher efficiency are to pair samples 
together on arrays in a way that optimizes experimental interests and then to make sure the analysis of 
the data is conducted appropriately.

The previous discussion of blocking factors and split-plot designs has direct bearing here.   If we narrow 
our focus to all the data from a single gene, and assume there is only one spot for that gene on each 
array, then the data come in pairs corresponding to the two measurements from each array.   Each array 
can therefore be considered as a block of size two. Alternatively, in a split-plot scenario where certain 
factors are hard to change, you desire more precise information on some factors versus others. In these 
situations, you can consider arrays to be whole plots and assign certain factors to change within whole 
plots (subplot factors) and others to stay constant on the whole plots (whole-plot factors).

Here we use the Drosophila aging experiment described by Jin et al. (2001) as an example to consider 
for experimental design options for two-channel microarrays. A subset of these data is included with 
your JMP Genomics installation and is described in Introduction to JMP Genomics.   This design has 
three experimental factors with two levels each: Age (1 week, 6 weeks), Sex (Female, Male), and Line 
(Oregon, Samarkand). 

Note: For higher-level factorial arrangements, experimental design experts often use exponential nota-
tion as a shorthand description. The Drosophila example would be called a 23 design, which designates 
3 factors with 2 levels each.

The primary experimental factor of interest is Age, and for this experiment it was desirable to obtain 
more precise information on the effects of Age at the expense of the Sex and Line effects. The latter 
two are still included to provide a higher degree of generalization for conclusions. These considerations 
call for a split-plot design.

Select DOE > Custom Design.

Define the three categorical factors and a fourth factor indicating the Channel. Specify Sex and Line 
as Hard in the Changes column, and leave Age and Channel as Easy. 

The completed dialog should appear as shown in Figure 2.18.



2
U

s
in

g
 J

M
P

 to
 D

e
s
ig

n
 N

e
w

 E
x
p

e
rim

e
n

ts
Chapter 2 Using JMP to Design New Experiments 31

Figure 2.18 The factors for the split-plot design have been specified

There are 24 assays available for experimentation.

Specify 24 in the Number of Whole Plots box in the Design Generation section (Figure 2.19).

Figure 2.19 The completed Design Generation section of the dialog

Click Make Design and then Make Table to generate the table shown in Figure 2.20.

Figure 2.20 The Experimental Design table

Note how Age and Channel change within whole plots, whereas Sex and Line stay constant for each 
whole plot. 

To convert this table to a valid JMP Genomics Experimental Design File (EDF), change the name of the 
Whole Plot column to Array by double-clicking on the column header and typing in Array as the 
new column name. Also, delete the Y column, since it will be replaced by a column named File. 

To compare this design with the original design in Jin et al. (2001), open the 
AgingExperimentTable.txt This file, which is included with JMP Genomics, is located in the Sample 
Data folder. Note the run order and randomization schemes are different, but the designs are similar in 
terms of their split-plot structure.
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Example 5: Randomized Block Design for Two-Channel 
Microarrays

Suppose that instead of the split-plot design just considered, equal information about the Age, Sex, 
and Line factors is needed and they need to be randomly allocated to the arrays in a randomized block 
design. A somewhat different approach in JMP illustrates a few more of its features.

Select DOE > Custom Design.

Define Dye as a 2-level categorical factor and Array as a 2-runs-per-block blocking factor as shown 
in Figure 2.21.

Figure 2.21 The completed Factors box

Click Continue.

Enter 48 runs in the Design Generation box as shown in Figure 2.22.

Figure 2.22 The completed Design Generation box

Click Make Design and then Make Table to generate the table shown in Figure 2.23.

Figure 2.23 The Experimental Design table
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The experimental design table establishes the static portion of the design and ensures that Cy3 and Cy5 
always appear once in each array.

Make sure that the experimental design table is open and in focus.

Select DOE > Custom Design to open a new DOE-Custom Design dialog.

Click Add Factors > Covariate in the Factors section

Select Dye, and click OK, as shown in Figure 2.24.

Figure 2.24 Selecting the first covariate

Click Add Factors > Covariate again.

Select Array, and click OK to generate the Factors section shown in Figure 2.25.

Figure 2.25 Both covariates have been specified

Note: JMP considers a covariate to be a factor describing fixed characteristics of the samples that do not 
change. Also note the levels of the two covariates Dye and Array are automatically read from the active 
JMP table because it is a previously created JMP table. In addition to loading factors from an active 
JMP table, you can save and load factors by clicking on the small red triangle beside Custom Design.

Next, we must define the three experimental factors Age, Sex, and Line. Since all three of these factors 
have two levels, they can be added to the design at the same time.

Type 3 in the Add N Factors box.

Click Add Factor > Categorical > 2 Level.

Three new rows are generated in the Factors section of the dialog.

Change each row to match the Factors section shown in Figure 2.26.
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Figure 2.26 The completed Factors section

Click Continue.

Highlight Age, Sex, and Line in the Factors section.

Select Interactions > 3rd in the Model section to produce the Model section shown in Figure 2.27.

Figure 2.27 The Model section with all factors and interactions defined

Click Make Design and then click Make Table to generate the Experimental Design table shown 
in Figure 2.28.

Figure 2.28 The randomized block design
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This randomized block design allocates 2 of the 8 possible treatment combinations to each array. This 
previous design is also known as a kind of loop design (Kerr and Churchill, 2001), and is illustrated in 
Figure 2.29. 

Figure 2.29 Loop design for 4 experimental conditions

The term loop derives from the fact that the design can be depicted as nodes indicating samples treated 
with one particular experimental factor combination. Aliquots of RNA from each sample are labeled 
either with the CY3 (green) or CY5 (red) florescent dyes. Two labeling reactions are required for each 
sample. Pairs of alternately labeled samples are pooled and hybridized to identical arrays. Each spot is 
probed with each sample, labeled with either dye, allowing the experimenter to control for confound-
ing biases resulting from either dye or array effects. 

Microarrays with Three or More Channels
With microarrays having three or more channels, the previous discussion for two-channel designs can 
be extended.   For incomplete block designs, set the number of runs per block equal to the number of 
channels and set up the other factors as usual. For split-plot designs, set the number of whole plots 
equal to the number of budgeted arrays.
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Microarrays with More than One Spot per Gene on Each Array
Some microarrays, often those manufactured in your local lab, have multiple spots per gene on the 
array.   Such two-color arrays pose no additional concerns from a new experimental design perspective 
because the samples are applied to the entire array. However, the existence of multiple spots does make 
a difference during subsequent data analysis, when random effects caused by such things as the nesting 
of identical spots within an array or differences in dye effects among multiple arrays should be consid-
ered, in addition to the usual Array random effect. 

Choosing the Overall Number of Runs in a Design
Selecting the number of runs in a design is always a trade-off between cost of the experiment versus the 
desired information gain, precision, or power.   The latter can be difficult to quantify, considering that 
tens of thousands of genes or proteins are measured simultaneously. 

One rule of thumb is to use three biological replicates for each distinct combination of factors. A bio-
logical replicate is a biologically unique sample from the population of samples considered for experi-
mentation. This is to be distinguished from a technical replicate, which is a repetitive measurement 
from biological material already used in a previous run.   Biological replicates tend to be much more 
variable than technical replicates, but they also provide the best means to make appropriate conclusions 
about the population of interest. 

A more statistical concept for evaluating size of designs is degrees of freedom for error. This represents the 
fraction of the data that is used to estimate noise instead of signal. It is computed by subtracting the 
total number of factor combinations from the total number of runs.   Another rule of thumb requires at 
least 10 degrees of freedom for error in the design in order to be able to obtain an accurate estimate of 
noise and accompanying standard errors for effect differences.

A rigorous statistical approach for determining the number of replicates in a design is to use sample size 
and power calculations.   These require some prior knowledge about anticipated magnitudes of effect 
sizes as well as desired false positive rates.   Some common methods are available under DOE > Sample 
Size and Power, and a few advanced ones are under Genomics > Power and Sample Size. Refer to 
the JMP Design of Experiments Guide for additional information.



Chapter 3
Configuring JMP Genomics Settings

What does it do?
The Configure Genomics Settings process enables you to define the specific parameter settings and 
defaults used by JMP Genomics processes, to configure JMP Genomics for grid computing, and to 
specify the name of the proxy server through which your organization can access with the Internet.

Caution: Changing the default settings can potentially impact the performance and outcome of JMP 
Genomics processes. You should contact your information systems administrator before running this 
process.

The Dialog
The dialog for the Configure Genomics Settings process consists of three tabs General, Grid, and 
Proxy . The fields and buttons on each tab are described. The  buttons provide additional informa-
tion for specific features. Fields and selections in which input is required for the AP to run successfully 
are labeled (required).

The General tab, shown in Figure 3.1, is used to specify the names and locations of input, output and 
settings files and folders, data files and the folder where all of the output will be placed. You have a great 
deal of latitude in specifying the names and locations of the default folders and you are free to choose 
the names and locations that best serve your needs.



38 Configuring JMP Genomics Settings Chapter 3

Figure 3.1 The General tab

Name of this Settings Profile field

• Use this field to specify a name by which this profile is saved. You can subsequently load this 
setting by clicking Load. 

Default Input Folder field

• Use this field to specify a default location for input data sets.

• Either click Choose to browse to the folder or type the path to and name of the folder in the 
field.

Default Library Folder field

• Use this field to specify a default location for library files needed by various input engines.

• Either click Choose to browse to the folder or type the path to and name of the folder in the 
field.

**
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Default Annotation Folder field

• Use this field to specify a default location for annotation data sets.

• Either type the path to and name of the folder in the field or click Choose to browse to the 
folder.

Default Settings Folder field

• Use this field to specify a default location in which to save settings.

• Either type the path to and name of the folder in the field or click Choose to browse to the 
folder.

• Note: You must have write permissions for this folder.

Default Output Folder field

• Use this field to specify a default location in which to save all of the output from various JMP 
Genomics processes.

• Either type the path to and name of the folder in the field or click Choose to browse to the 
folder.

• Note: You must have write permissions for this folder. 

• Note: You should not specify the My Documents folder as the output folder, although you can 
specify subfolders within My Documents.

Default Server Output Directory field 

• Use this field to specify a default location on a server in which to save all of the output from 
various JMP Genomics processes. This default applies only when you are connected to a SAS 
metadata server.

• Type the path to and name of the folder in the field or click Choose to browse to the folder.

• Note: You must have write permissions for this folder. 

Archive the SAS code check box

• This option enables you to generate a single SAS program containing all of the SAS code used 
every time you run a process that uses SAS code. 

• A new file is generated every time you run a process that uses SAS code. The resulting SAS 
program is deposited in the specified output folder.

Archive the resolved SAS macro code check box

• This option enables you to generate a single SAS program containing all of the resolved SAS 
macro code used. 

• A new file is generated every time you run a process that uses SAS code. The resulting SAS 
program is deposited in the specified output folder.

• Caution: Checking this option can substantially increase computational times.
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Output Folder field (required)

• The field shows the path to the folder where the output data set is to be placed.

• The Choose button enables you to browse to the selected folder.

• Note: The default output folder is C:\Documents and Settings\ ** \Local 
Settings\Application Data\JMPG\, where ** is your user ID.

The Grid tab, shown in Figure 3.2, is used to configure the JMP Genomics for grid computing. You 
must specify all of the parameters on this tab for any to be saved.

Figure 3.2 The Grid tab

Note: To run JMP Genomics on a grid you must have access to and authorization for a SAS metadata 
server running SAS Grid Manager software. You should contact your information systems administra-
tor for assistance in specifying the grid settings if you plan to run JMP Genomics on a grid. 

Metadata Server Name field

• Use this field to specify the name of the SAS metadata server running SAS Grid Manager soft-
ware.

Port Number field

• Use this field to specify the port number for the SAS metadata server.

Repository Name field

• Use this field to specify the name of the SAS metadata repository.

User Name field

• Use this field to specify the name of a user authorized to access the SAS metadata server.

Password field

• Use this field to specify the password associated with the authorized user name specified 
above.

• You can leave this field blank. If left blank, you must enter the password each time you run a 
JMP Genomics process on the grid.
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Shared Grid Folder field

• Use this field to specify the path to a shared folder for which all nodes on your grid have read 
and write access. The pathname for this folder must be recognizable by all nodes. A UNC 
path specification (for example, \\machine\folder\subfolder) is recommended. 

• Caution: If the shared path is on a Windows XP machine, then you are only able to use a max-
imum of 8 grid nodes because of a limitation on the number of users that can simultaneously 
access a shared folder. If you want to use more than 8 grid nodes, specify a shared path on a 
server. 

The Proxy tab, shown in Figure 3.3, is used only if your organization accesses the Internet through a 
proxy server. Use this tab to specify the name and your proxy port number. You must specify both 
parameters for this setting to be used. You should contact your information systems administrator for 
the name and port number for your proxy server.

Figure 3.3 The Proxy tab

Proxy Server Name field

• Use this field to specify the name of your proxy server. Type the name in the form server-
name.domain.com. 

• If your computer does not access the Internet through a proxy server, you must leave this field 
empty (Blank). 

Proxy Port Number field

• Use this field to specify the proxy port number. 

• If your computer does not access the Internet through a proxy server, you must leave this field 
empty (Blank). 

The action buttons at the bottom of the dialogs are described in Introduction to JMP Genomics.

Results
Specify all of the parameters that need to be reconfigured.

Click Run.

A new settings file is generated and placed in the specified folder. All affected parameters are set to the 
new defaults..
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Chapter 4
Using JMP Genomics in Client/Server Mode

JMP Genomics was originally designed to run as a stand-alone desktop application. Both the JMP and 
SAS components are installed on a single machine and all analytical procedures and computations are 
performed on that one machine. Even though desktop PCs are becoming increasingly powerful, it 
might make sense to use a remote SAS server to alleviate the computational load on your local machine, 
especially for CPU- and I/O-intensive calculations. 

With the release of JMP Genomics 4.1, the ability to operate over a client/server configuration has been 
added experimentally to JMP Genomics. In this mode, SAS is installed on a server while the JMP com-
ponents are installed on one or more client machines. Data files are either stored on the server or are 
copied to the server from the client during the execution of the analytical process. Jobs set up on the cli-
ent are sent to the server where they are run; results are surfaced back to the client. The advantages to 
this configuration are numerous: server machines typically have greater computing capabilities than the 
typical desk top machine and jobs can run in much less time; hard disk space is usually much more 
plentiful; the analytical procedures, which can tie up considerable amounts of resources, are carried out 
elsewhere, thus freeing up desktop machines for other purposes; and, finally, multiple users can use the 
same SAS installation.

Instructions for installing and configuring JMP Genomics in client/server mode are provided below. If 
you are not comfortable setting this up on your own, you should contact your system administrator for 
assistance.

Note: The addition of client/server functionality does not affect the ability of JMP Genomics to run as 
a stand-alone desktop application. However, the SAS server-side components must be licensed sepa-
rately. The required products on the server are: Base SAS, Integration Technologies, SAS/STAT, SAS/
Genetics, SAS/GRAPH, SAS/IML, and Access to PC File Formats. 

Prerequisites
In order to run JMP Genomics in Client/Server mode, you must have access to fully functional SAS 
9.2 metadata server. You also need write access to a directory on the server machine. This folder is used 
to hold the results of analysis runs performed on the server. 

Note: If you want to keep the results for different runs in separate folders on the server, change the 
server output path prior to each run.

Consult your systems administrator to obtain the necessary authentication credentials for accessing the 
metadata server. 
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Configuring JMP Genomics to Run in Client/Server Mode
Before you can set up your metadata server profile, you must configure JMP Genomics to run in client/
server mode. 

First, on the server machine, you need a working directory to which you have write permissions. This 
directory will be used by JMP Genomics both for copying over all required files and as a work space 
during calculations. You should use network tools, such as Telnet or ssh, for example, to connect to a 
unix-based machine and create a directory.

Note: You should contact your system administrator if you need assistance in setting up this directory.

Next, on your client machine, you must save the path to the directory on the server in JMP Genomics.

Open JMP Genomics.

Select File > Configure Genomics Settings to open the dialog shown in Figure 4.1.

Figure 4.1 The Configure Genomics Settings dialog

Type the name of the directory created above in the Default Server Output Directory field, as shown 
in Figure 4.2.
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Figure 4.2 The completed Default Server Output Directory field

Note: Running Configure Genomics Settings with a Default Server Output Directory specified results 
in this directory name being automatically filled in whenever you run in experimental client/server 
mode and open a new dialog.

Click Run.

Close the Configure Genomics Settings dialog and message windows.

Setting Up Your Metadata Server Profile and Connecting to the 
Metadata Server

Before you can connect to the SAS metadata server, you must set up a metadata server profile.

Select File > SAS > Server Connections to open the SAS Server Connections window shown in 
Figure 4.3.

Figure 4.3 The SAS Server Connections window

Select SAS version 9.2 from the SAS Server Version drop-down menu shown in Figure 4.4.
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Figure 4.4 Selecting SAS version 9.2

Click Metadata Server Profiles to open the Manage Metadata Server Profiles window shown in 
Figure 4.5.

Figure 4.5 The Manage Metadata Server Profiles window

Click Add to open the Create Profile window shown in Figure 4.6.

Figure 4.6 The Create Profile window

Specify a name and description for your metadata server profile in the Profile name field. 

Type the name of the server in the Machine field.

Note: The name of the server should contain no spaces. Individual identifiers are usually separated by 
dots (MachineName.unx.sas.com, for example).

Type the port number in the Port field

Type your authenticated user name and password for the server in their respective fields.
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Note: If you do not have an authenticated user ID and password, contact your system administrator.

The completed Create Profile window appears as the example shown in Figure 4.7.

Figure 4.7 The completed Create Profile window

Click Save to save your profile and close the Create Profile window.

The completed Manage Metadata Server Profiles window appears as shown in Figure 4.8.

Figure 4.8 The completed Manage Metadata Server Profiles window

Click Connect.

A blue Connection Belt symbol (Figure 4.9) appears next to you profile name when you have success-
fully connected to the metadata server. If it does not appear, modify your profile accordingly or contact 
your system administrator for assistance.

Figure 4.9 A successful connection has been established.

Close the Manage Metadata Server Profiles and SAS Server Connections windows. 

You are now in Client/Server mode. As long as the connection is maintained, all JMP Genomics APs 
will run SAS on the metadata server. 

To return to standard local mode:
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Select File > SAS > Server Connections. 

Click Metadata Server Profiles and click Disconnect.

Running an AP in Client/Server Mode
Before you can run a JMP Genomics AP in client/server mode, you must be connected to the SAS 
metadata server, as described in the previous section.

Open the AP (Distribution Analysis, for example) you want to run.

Whenever an active connection to the metadata server is open, a new Server Output Directory field 
listing the server output directory specified in the Configuration step above is shown at the bottom of 
the dialog on the General tab (Figure 4.10).

Figure 4.10 The Distribution Analysis dialog displaying the Server Output Directory field

To run the AP in client/server mode:

Load your setting or specify the input data sets and the analysis parameters as usual.

Note: When you click run, all of the input files are copied to the server. If the input files that you need 
are already on the server, you can type or paste server paths directly into input data set and path fields.

Click Run.

The AP runs on the server and returns the results to your desktop client machine.
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Note: the first time you load settings or run an AP, during a JMP Genomics session, you are prompted 
to select a SAS work space server. Select the appropriate work space server (for example SASApp) from 
the window. This work space server is then used for the remainder of your session.

A copy of raw data files, data sets, SAS code, and results remain on the server in your server directory.   
You might wish to check this directory from time to time and delete unwanted files to save disk space. 
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Appendices
The information in the following appendices is provided to make your use of JMP Genomics easier and 
more informative. They include a table listing the suffixes used to identify all of the different data sets 
output by JMP Genomics, a glossary and a Troubleshooting guide and a comprehensive bibliography.
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Chapter 5
Using JMP Genomics Graphics in Presentations 
and Publications

When you need JMP Genomics graphics or data tables for use in another program, such as Microsoft 
Word or PowerPoint, you can copy and past all or part of the graphic or table into the other program. 

• Click the selection tool ( ). 

• Click and drag (or Shift-click) to select items in a JMP graphics window or data table. 

Note: Clicking near the edge of the window selects the entire window. 

• Click Edit > Copy to copy the selected item(s) in JMP Genomics. 

• Click Edit > Paste Special in the target application, select Windows metafile (.wmf ) as the 
format and click OK to paste the selected item into the other program. 
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Chapter 6
The SAS WHERE Expression

What does it do?
A WHERE expression is a type of SAS expression that allows you to filter and select observations meet-
ing one or more specific defined criteria. A WHERE expression can be as simple as a single variable 
name. A WHERE expression can contain a SAS function, or it can be a sequence of operands and oper-
ators that define one or more conditions for selecting observations. 

The WHERE expression
A SAS WHERE expression contains the WHERE keyword, one or more operands and one or more 
operators, and takes the following general form:

WHERE operand operator operand

Note: Blank spaces must be entered between each element in a WHERE expression.

The WHERE keyword alerts SAS to subset the data set.

An operand is an object to be operated on. An operand can be a variable (or column in a SAS data set), 
a SAS function (the result of a computation or other manipulation), or a constant.

An operator is a symbol that requests a comparison, a logical operation, or arithmetic computation.

WHERE expressions may either be simple or compound. Simple WHERE expressions contain only one 
condition that must be satisfied. Compound WHERE expressions contain more than one condition 
that must be satisfied, with each condition being separated by Boolean terms, such as and or or.

For example, to filter only diseased individuals from a data set containing a mixed population of dis-
eased (sick) and healthy (healthy) individuals (as indicated in a column named DiseaseStatus), you 
could use the following simple WHERE expression:

WHERE DiseaseStatus = ‘sick’

To simultaneously filter diseased individuals who also possess the genotype A/A (as indicated in a col-
umn named Marker1), you could use the following compound WHERE expression:

WHERE DiseaseStatus = ‘sick’ and Marker1 = ‘A/A’
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Using a WHERE expression in JMP Genomics
Recall that JMP Genomics runs SAS in the background for manipulation and analysis of genomics data 
sets. Any statements or commands, including WHERE expressions, that can be used in SAS can also be 
used in JMP Genomics. However, because JMP dialogs function as the front end for generating and 
running the underlying SAS code, you don’t need to understand all of the syntax for writing WHERE 
expressions. Instead, you are prompted by specific data entry fields (identified by the title: Filter to 
Include...)to specify the relevant operands and operators.

The Filter to Include Observations field (Figure 6.1), for example, found on many JMP Genomics dia-
logs, simplifies the specification of a WHERE expression. 

Figure 6.1 The Filter to Include Observations field

Note that the WHERE keyword has already been specified. There is no need to type the WHERE key-
word. All you need to do is type the operands and the operators in the field. 

To use the previous example, type DiseaseStatus = ‘sick’, as shown in Figure 6.2, to retain 
only the diseased individuals from the input data set.

Figure 6.2 A WHERE expression to retain diseased individuals

The filter is applied when you click Run.

Specifying an Operand
An operand is defined as the object to be operated on or the condition to be met. Operands can be 
either variables, SAS functions, or constants.

The variable names used in this statement (e.g., GeneId, Position) must exactly match those in the 
Input Data Set. 

Variables

A variable is a column in a SAS data set. Each variable has a name and a type (numeric or character) 
and contains values. 

You must type the name exactly as it appears in the data set.

The values listed in numeric variables must be numeric. Character variables may contain numbers, let-
ters, and symbols. The variable type determines how you specify that variable. 
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To filter the data based on a numeric variable, type the name of the variable followed by a space, the rel-
evant operator followed by a space, and the condition to be met. For example, to select only those rows 
whose numeric value in the Freq variable exceeds 0.5, type Freq > 0.5 in the Filter field.

SAS treats numeric values of zero (0) or that are missing (.) as false. All other values are true. 

To continue the example listed above, to filter out those frequency observations that are not reported 
(indicated by the missing value symbol (.)), type Freq in the Filter field. 

To filter your data using a character variable, you must enclose the character string defining the condi-
tion to be met within quotes. For example, to filter only the diseased individuals, type 
DiseaseStatus = ‘sick’ in the Filter field. You may use either single quotes (‘x’) or double quotes 
(“x”), however, you must be consistent in the quotes you use. If you open the condition with a single 
quote you must close it using a single quote, and vice-verse. You cannot mix single and double quotes 
(‘x”, for example) within the same expression.

SAS Functions

A SAS function returns a value from a computation or system manipulation. Most functions use argu-
ments that you supply. To use a SAS function in a WHERE expression, type the name of the function 
followed by the argument. The argument must be contained within parentheses.

The SUBSTR function examines the character strings in a variable for a specific substring and retains 
only those observations containing the specified substring. The argument for this function specifies the 
variable containing the substring, the position within the string at which the substring starts, and the 
length of the substring. For example, typing the estimation substr (GeneName,1,3) = 
“cyt” in the Filter field subsets the input data set so that only observations in which the character 
value in the GeneName column begins with cyt , such as cytosolic or cytochrome are retained. Others, 
such as lymphocyte, are not.

Many additional, legitimate SAS functions can be used in WHERE estimations; for example TODAY, 
which returns the current data, however, most of these tend not to be very useful in genomics analysis 
and so, are not discussed further here.

Please refer to Base SAS documentation for further details about use of SAS functions in WHERE 
expressions, if you require more information.

Constants

A constant is the fixed value within a variable for which you are searching. The value is either numeric 
or character. Constants are also called literals. For example, a constant could be a specific genotype. 

As with character and numeric variables, if the constant is a character, you must type either single or 
double quotation marks before and after the value. Remember, you cannot mix single and double 
quotes (‘x”, for example) within the same expression. Do not use quotes if the constant is numeric. 

Specifying an Operator
An operator is a symbol that requests a comparison, a logical operation, or arithmetic computation. 
When writing the WHERE expression, you should place the operator between two operands. 
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Comparison Operators

Comparison operators (also called binary operators) compare a variable with a value or with another 
variable. Comparison operators propose a relationship and ask SAS to determine whether that relation-
ship holds. Only observations that meet the condition(s) specified are included in the analysis.

The comparison operators, available to you in JMP Genomics, are shown in Table 6.1.

Table 6.1 Comparison Operators

You may combine comparison operators into compound WHERE expressions. For example, typing 
50000 <= Position <= 100000 includes only those observations whose values listed in the 
Position variable are greater than or equal to 50,000 and are less than or equal to 100,000.

Note: The combination of the > and < symbols (as in 7 > x < 9, for example) is not supported.

Remember: You do not need to type WHERE in the Filter field.

Symbol Definition Example

= or EQ • equal to • Typing Gene EQ “EGF” subsets the input 
data set, retaining only those observations 
where the value in the Gene column is EGF.

^= or NE • not equal to • Typing IndividualNum ^= 450 subsets 
the input data set, retaining only those obser-
vations where the value in the IndividualNum 
column is 450.

< or LT • less than • Typing Position < 100000 subsets the 
input data set, retaining only those observa-
tions where the position value is less than 
100,000.

> or GT • greater than • Typing Position GT 100000 subsets the 
input data set, retaining only those observa-
tions where the position value is greater than 
100,000.

<= or LE • less than or equal to • Typing Position <= 100000 subsets the 
input data set, retaining only those observa-
tions where the position value is less than or 
equal to 100,000.

>= or GE • greater than or equal to • Typing Position GE 100000 subsets the 
input data set, retaining only those observa-
tions where the position value is greater than 
or equal to 100,000.
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Arithmetic Operators

Arithmetic operators enable you to perform a mathematical operation on values in the specified oper-
and. 

The arithmetic operators, available to you in JMP Genomics, are shown in Table 6.2.

Table 6.2 Arithmetic Operators

Remember: You do not need to type WHERE in the Filter field.

Additional Operators

Additional operators can be used to select observations matching or containing a specified set of charac-
ters, missing values, to concatenate variables, return minimum or maximum values, etc.

The most useful of these operators are the IN, CONTAINS, and IS MISSING operators shown in 
Table 6.3.

Symbol Definition Example

* • multiplication • Typing x = y*0.1, in the Filter field selects 
and returns observations whose values in the x 
column are equal to the corresponding y col-
umn values multiplied by 0.1.

/ • division • Typing x = y/10, in the Filter field selects 
and returns observations whose values in the x 
column are equal to the corresponding y col-
umn values divided by 10.

+ • addition • Typing x = y+1, in the Filter field selects 
and returns observations whose values in the x 
column are equal to the corresponding y col-
umn values plus one.

- • subtraction • Typing x = y-1, in the Filter field selects 
and returns observations whose values in the x 
column are equal to the corresponding y col-
umn values less one.

** • exponentiation • Typing x = y**2, in the Filter field selects 
and returns observations whose values in the x 
column are equal to the square of the corre-
sponding y column values.
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Table 6.3 Additional Operators

Prefix Operators

Prefix operators are added to modify existing operators in a WHERE expression. The most commonly 
used prefix operator is NOT. Placing this prefix before the normal operator selects those observations 
not matching the specified condition.

Table 6.4 NOT is a prefix operator

The + and - symbols, which typically serve as arithmetic operators, also function as prefix operators 

when put in front of an open parentheses. Typing z = -(x + y) in the Filter field returns observa-

tions whose value for z equals the negative of the sum of the values in x and y.

Compound WHERE Expressions

You might find it useful to combine multiple simple WHERE expressions into a single compound into 
a single, compound WHERE expression. Expressions can be joined either by using Boolean terms, such 
as AND and OR, or by grouping arguments within parentheses.

Symbol Definition Example

IN • equal to one of a list • Typing Window IN (1,4,9,32) subsets 
the input data set, retaining only those obser-
vations where the value in the Window col-
umn is equal to either 1, 4, 9 or 32.

 CONTAINS • contains a specified set of 
characters

• Typing GeneName CONTAINS “cyt” 
subsets the input data set, retaining only those 
observations where the value in the 
GeneName column contains the string cyt 
(for example all of the cytochrome genes).

IS NULL or IS 
MISSING

• value is missing • Typing GeneName IS MISSING subsets 
the input data set, retaining only those obser-
vations where the value in the GeneName col-
umn is absent.

• This operator can be combined with the NOT 
operator.

Symbol Definition Example

NOT • value does not match 
specified characters

• Typing GeneName NOT “cyt” subsets 
the input data set, retaining only those obser-
vations where the value in the GeneName col-
umn is not cyt.
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For example, typing GeneName CONTAINS “cyt” OR “Fed” in the Filter field selects and 
returns all rows with these character strings in the GeneName columns. Alternatively, typing Gene-
Name CONTAINS (“cyt”, “Fed”) does the same.

Additional Information

Please refer to Base SAS documentation for additional operators, as needed.
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Chapter 7
JMP Genomics Files Are Identified by Suffixes

Typical analyses in JMP Genomics often generate a large number of output files and data sets. This is 
especially true when input and output files are contained with the same folder, when an AP produces 
multiple output files, or when the same output folder is used for multiple processes. If any or all of 
these conditions occur, the number of files in a folder can multiply dramatically. How do you identify 
and distinguish between the different files? More importantly, how do you prevent overwriting existing 
files with the output of subsequent APs, particularly when all of the files tend to be similarly named?

JMP Genomics adds a unique suffix to each output file generated by an AP. Suffixes are specific to each 
AP and are dependent on the type of content contained in the file. These suffixes allow you to identify 
different output files and to correlate them with specific APs. All of the suffixes used by JMP Genomics 
are listed alphabetically in the table below. Each suffix is defined both by the AP that generates it and by 
the contents of the file that carries it.

Note: Even with the suffixes, it is still possible to overwrite existing files. You should take care to specify 
different names for output files when doing multiple runs with the same input files. Alternatively, you 
may specify different output folders.

JMP Genomics Files have suffixes: Identification of output files by suffix, AP, and contents.

File Suffix APs Generating the File Function/Contents of the File

_aag • Create Annotation Analysis 
Group Variables 

Output data set listing the input data plus the anno-
taion analysis group variable 

_afreqs • Marker Properties Output data set containing allele frequencies

_agc • Correlation and Grouped 
Scatterplots.

Output data set consisting of the input data merged 
with the annotation data set

_alp • Affymetrix Cytogenetics 
CHP Input Engine

Output data set 

_amr • ANOVA Output data set listing annotation information and 
various statistics for the most significant markers
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_anm • ANOVA Normalization Output data set with the same structure as the input 
data set but with normalized response variables

_api • PseudoImage Output data set listing the X- and Y-coordinates, 
probe set IDs, and intensities for each spot on the 
specified array

_ars • ANOVA
• One-Way ANOVA

Output data set listing standardized residuals for 
each observation in the input data set

_as • Relationship Matrix Output data set listing the relationship matrix gener-
ated using the allele sharing similarity estimate.

_asf • Allele Specific Expression 
Filter

Output data set containing the filtering results.

_asp • Affected Sib-Pair Tests Output data set containing affected sib-pair test sta-
tistics and .jsl file for plotting p-values

_asr • Allele Specific Expression 
Filter

Output data set containing the log-ratio of RNA 
intensity data for estimated homozygous genotypes

_atan • ArrayTrack Annotation file created by ArrayTrack

_bin • Copy Number Bin Output data set listing the bins into which the probe 
sets have been grouped. This data set also lists the 
physical position of the bin start site and the average 
intensity across the bin.

_bnm • Batch Normalization Output data set containing the batch-normalized 
data

_bnp • Batch Normalization Output data set containing the results of the princi-
pal components analysis

_bowa • Bivariate One-Way ANOVA Output data set containing annotation data, and sta-
tistics on individual experiments and pair-wise com-
parisons

_box • Distribution Analysis Output data set listing the relative densities of spots 
on each array grouped by similar responses; used for 
drawing Box plots

_bsc • Batch Scoring Output data set containing the batch-normalized 
data

JMP Genomics Files have suffixes: Identification of output files by suffix, AP, and contents.

File Suffix APs Generating the File Function/Contents of the File
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_bypathwayid • KEGG Pathway Search Output data set listing the various pathways and 
affiliated genes for each gene entered in the Gene/
Protein IDs field

_cca • Case-Control Association Output data set containing case-control association 
test statistics and .jsl file for plotting p-values

_ce • Combinve Experiments Output data set generated from the merging of mul-
tiple tall SAS data sets.

_ceb • Column Enrichment Output data set listing the categories that show 
results displaying significance as specified by the 
binary significance variables

_cec • Column Enrichment Output data set listing the categories that show 
results displaying significance as specified by the con-
tinuous significance variables

_ceexp • Combine Experiments Output experimental design data set

_cef • Column Enrichment Output data set containing the Fisher Exact test 
results for the binary significance variables

_cep • Column Enrichment Output data set containing PAGE results for the 
continuous variables.

_chrm • Affymetrix Cytogenetics 
CHP Input Engine

Output data set 

_cim_out • IM and CIM Analysis Output data set listing position and associated LOD 
scores for each marker

_cml • IM and CIM Analysis Output data set listing the control markers used in 
the analysis

_cor • Correlation and Principal 
Components

• Cross Correlation

Output data set listing the correlation of all the dif-
ferent variables in the input data

_cov • Correlation and Principal 
Components

Output data set listing the covariates of all the differ-
ent variables in the input data

_cpg • SNP-Trait Association
• Imputed SNP Trait 

Association
• Q-K Mixed Model

Output data set containing covariance parameter 
estimates for the genotype test. This data set is gener-
ated whenever any random effects are specified.

JMP Genomics Files have suffixes: Identification of output files by suffix, AP, and contents.

File Suffix APs Generating the File Function/Contents of the File



66 JMP Genomics Files Are Identified by Suffixes Chapter 7

_cpt • SNP-Trait Association
• Imputed SNP Trait 

Association
• Q-K Mixed Model

Output data set containing covariance parameter 
estimates for the trend test. This data set is generated 
whenever any random effects are specified.

 _csn • Control Set Normalization Output data set containing the normalized data

_csne • Control Set Normalization Output experimental design data set

_dap • Append A concatenated data set resulting from appending 
the rows of two different data sets

_data • Exon and Whole Transcript 
Expression CEL

SAS data set containing the imported data

_den • Distribution Analysis Output data set used for plotting the overlayed ker-
nel density estimate plot

_dge • Distribution Analysis Output experimental design data set when using 
Group variables

_dgm • Distribution Analysis Output data set when using Group variables

_dlb • Change Labels Output data set in which the variables of the original 
data set have been relabeled

_dln • Change Lengths The output data set in which the lengths of the vari-
ables of the original data set have been resized

_dmg • Merge The large data set resulting from merging two 
smaller data sets

_dmt • Distance Matrix Output data set listing the measures of dissimilarity 
between all pairs of observations in the experiment

_drk • Rank Rows The output data set in which the individual values 
within each variable have been replaced with the 
ranking of that observation within the variable

_drn • Rename The output data set in which the primary variables of 
the original data set have been renamed

_dro • Reorder The output data set in which the order of the vari-
ables in the original data set has been changed

JMP Genomics Files have suffixes: Identification of output files by suffix, AP, and contents.

File Suffix APs Generating the File Function/Contents of the File
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_drs • Statistics for Rows Data set listing row-wise statistics for the primary 
data set. Rows meeting the criteria specified in the 
Delete Rows Satisfying this Expression box on the 
Options tab are excluded from the data set.

_dsa • Discriminant Analysis Output data set containing all of the data from the 
input data set plus three additional columns. These 
include observation number, and two columns list-
ing the predicted values for the dependent class vari-
able.

_dsav • Discriminant Analysis Lists the names of the variables selected and used for 
making predictions

_dsm • Statistics for Columns Data set listing summary statistics for the variables in 
the primary data set

_dso • Distance Scoring Lists the statistics and associated predictions for each 
of the individuals in the input data set

_dsov • Distance Scoring Lists the names of the variables selected and used for 
making predictions

_dsp • Data Step The modified data set resulting from executing SAS 
data step commands on a data set

_dss • Subset Output subset data set

_dst • Sort Rows The output data set in which the variables in the 
input data set have been sorted according to specified 
key variables

_dtf • Transform The output data set resulting from the mathematical 
transformation of specified variables in a primary 
data set

_dtr • Transform Rectangular The data set resulting from the transposition of a 
block of variables in the original data set

_eig • Correlation and Principal 
Components

• Relationship Matrix

Output data set listing the eigen values and associ-
ated experimental statistics

_esc • Gene Set Scoring Output data set containing the scored data

_est • Estimate Builder/Compare 
Means

Output file containing the estimate statements

JMP Genomics Files have suffixes: Identification of output files by suffix, AP, and contents.

File Suffix APs Generating the File Function/Contents of the File
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_exp • Many different input 
engines, data set utilities 
and analytical processes

Experimental Design Data Set (EDDS)

_fff • Feature Flagger Output data set in which individual values for the 
variables have been replaced with "0", if values are 
within defined parameters, or "1", if values are out-
side of those parameters

_fin • Filter Intensities Output data set listing the filtered intensities

_fnm • Factor Analysis 
Normalization

Output data set with the same structure as the input 
data set, but with normalized response variables

_gfreqs • Marker Properties Output data set containing genotype frequencies

_glm • General Linear Model 
Selection

Lists the statistics and associated predictions for each 
of the individuals in the input data set

_glmv • General Linear Model 
Selection

Lists the names of the variables selected and used for 
making predictions

_gms • Gene Model Summary Output data set containing the summarized data

_gp • Build Genotype Probability 
Data Set

Output data set listing the probabilities of observing 
specific QTL genotypes at each one cM interval 
along the chromosome(s)

_gse • Gene Set Enrichment Output data set containing enrichment test results

_gsei • Gene Set Enrichment Output data setcontaining 0-1 indicator variables for 
the categories

_hc • Hierarchical Clustering Output data set containing all of the variables from 
the input data set plus results (row means and stan-
dard values, the cluster to which each belongs and its 
place within the cluster) of the hierarchical cluster-
ing.

_hest • Haplotype Estimation .html output files, .jsl file for plotting p-values, and 
output data set containing association test statistics 

_hfr • Haplotype Estimation Output data set containing haplotype frequency esti-
mates that can be used as input to the htSNP 
Selection process

JMP Genomics Files have suffixes: Identification of output files by suffix, AP, and contents.

File Suffix APs Generating the File Function/Contents of the File
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_her • Haseman-Elston 
Regression

Output data set containing Haseman-Elston regres-
sion test statistics and .jsl file for plotting p-values

_hph • Haplotype Estimation Output data set containing phase assignment proba-
bilities. This data set can be used as the input data set 
for the Haplotype Trend Regression process.

_hti • htSNP Selection Output data set that contains all the columns from 
the annotation data set with an additional htSNP 
Indicator column

_htr • Haplotype Trend 
Regression

.html output files

_hts • htSNP Selection .html output files, .jsl file for displaying htSNPs, and 
output data set containing htSNP information

_hwetest • Marker Properties Output data set containing HWE test statistics and 
other marker properties

_ibd • Relationship Matrix Output data set listing the relationship matrix gener-
ated using the identical by descent estimate.

_ibs • Relationship Matrix Output data set listing the relationship matrix gener-
ated using the identical by state estimate.

_igp • Imputed SNP (Wide 
Format) 

• Imputed SNP (Tall Format)

Stacked output genotype probabilities SAS data set 
containing probabilities for each genotype at a SNP 

_igt • Imputed SNP (Wide 
Format) 

• Imputed SNP (Tall Format)

Output genotype threshold SAS data set listing the 
most likely genotype for each SNP

_iqr • Data Standardize Output data set containing the IQR standardized 
values for the input data set

_ist • Imputed SNP-Trait 
Association

Output data set containing association test statistics 
and .jsl file for plotting p-values

_jnm • Johnson Su Normalization Output data set containing SU normalized data

_jnp • Johnson Su Normalization Output data set listing the four estimated parameters 
for each array used to generate the SU normalized 
data

_kc • K Matrix Compression Output data set containg the compressed matrix

JMP Genomics Files have suffixes: Identification of output files by suffix, AP, and contents.
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_kcv • K Matrix Compression Output data set containing the covariance parameter 
estimates from every mdoel fit duiring the compres-
sion

_kgi • KEGG Get Gene Identifiers Output data set containing a column listing the 
KEGG gene identifiers appended to the input data 
set.

_kgp • KEGG Get Gene Pathways Output data set containing a column listing the 
KEGG pathway identifiers appended to the input 
data set.

_kmc • K-Means Clustering Lists the center of each cluster and the corresponding 
statistics 

_kmd • K-Means Clustering Lists the statistics for each observation, the cluster to 
which the observation has been assigned and its dis-
tance from the cluster mean

_kmx • Kinship Matrix Output data set consisting of the input data modi-
fied to identify the parents of the different pedigrees 
and matrix statistics

_knn • K-Nearest Neighbors Lists the statistics and associated predictions for each 
of the individuals in the input data set

_knnv • K-Nearest Neighbors Lists the names of the variables selected and used for 
making predictions

_ld • Linkage Disequilibrium .jsl file for displaying LD results

_ldbc • LD Block Creation Output data set listing the name, location, LD block 
and annotation information for each of the SNPs

_ldc • Linkage Disequilibrium Output data set containing LD measures used in the 
Contour Plot and/or the LD Decay plot

_lds • Linkage Disequilibrium Output data set containing LD test statistics

_ldts • LD tagSNP Selection Output data set containing tagSNP information

_ldts_body • LD tagSNP Selection .html output file summarizing the tagSNP informa-
tion

_len • List Enrichment Output data set containing the list enrichment statis-
tics

JMP Genomics Files have suffixes: Identification of output files by suffix, AP, and contents.

File Suffix APs Generating the File Function/Contents of the File
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_lgr • Logistic Regression
• SNP Interaction Discovery

Output data set containing all of the data from the 
input data set plus three additional columns. These 
include observation number, and two columns list-
ing the predicted values for the dependent class vari-
able.

_lgrv • Logistic Regression

• SNP Interaction Discovery

Lists the names of the variables selected and used for 
making predictions 

_lnm • LoessNormalization Output data set containing the loess normalized data

_lnp • Loess Normalization Output data set containing data used for drawing the 
M-A plots

_map • Imputed SNP (Tall Format) 
Input Engine

Output data set containing annotation marker map 
information

_mdf • Multidimensional Scaling Output data set listing statics from the multidimen-
sional scaling process

_mdr • Multidimensional Scaling Output data set listing the statistics for and distances 
between pairs of observations from the input data set

_mds • Multidimensional Scaling Output data set listing the multi-dimensional coor-
dinates of each observation 

_mea • Data Standardize Output data set containing the mean standardized 
values for the input data set

_med • Data Standardize Output data set containing median standardized val-
ues

_meds • Data Standardize Output data set containing location and scale esti-
mates used to median-center the input values

_mgs • Missing Genotype by Trait 
Summary

Output data set listing the counts of genotyped cases 
and controls, the number of missing genotypes for 
cases and controls, and the statistics for testing for 
different missing proportions between cases and con-
trols for each marker

_mld • Malecot LD Map .jsl file for creating plots and output data set contain-
ing estimates of LDU between pairs of markers

_mml • Malecot LD Map Output data set containing estimates for parameters 
M and L

JMP Genomics Files have suffixes: Identification of output files by suffix, AP, and contents.
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_mmp • Mixed Model Power Output data set listing power values and associated 
t-statistics for a set of hypothesis tests for a range of 
alpha and effects sizes

_mmr • Mixed Model Analysis Lists annotation and statistical information for each 
of the groups

_mnm • Mixed Model 
Normalization

Output data set with the same structure as the input 
data set but with both the original and the normal-
ized response variables

_mrs • Mixed Model Analysis Output residual data set

_msd • Merge Gene Sets Output merged data set

_mtr • Merge and Transform The output data set resulting from the merging of 
two sets sharing a common set of variables and the 
subsequent computation of an arbitrary function for 
each pair of variables sharing the same name

_mta • Marker-Trait Asoociation Output data set containing association test statistics 
and .jsl file for plotting p-values

_mvi • Missing Value Imputation The complete output data set in which values miss-
ing from the input data set have been imputed from 
the non-missing values in the same row

_names • Nexus Output data set containing names of markers

_numgeno • Marker Properties Output data set containing numerically coded geno-
types used for the cell plot

_one • Single Marker Analysis Output data set listing the results of the regression 
analysis and -log2 p-values for association of each of 
the markers with each of the two quantitative traits, 
along with annotation information for each of the 
markers

_owa • One-Way ANOVA Output data set containing annotation data, and sta-
tistics on individual experiments and pair-wise com-
parisons

_pca • Principal Components 
Analysis for Population 
Stratification

• Principal Components 
Analysis

Output data set listing the row scores for each of the 
principal components

JMP Genomics Files have suffixes: Identification of output files by suffix, AP, and contents.

File Suffix APs Generating the File Function/Contents of the File
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_pcm • Pricipal Components 
Analysis for Population 
Stratification

Output data set containing the PCA data merged 
into the input data set.

_peg • SNP-Trait Association

• Survey SNP-Trait 
Association

Output data set containing the parameter estimates 
for the genotype test.

_pet • SNP-Trait Association

• Survey SNP-Trait 
Association

• Imputed SNP-Trait 
Association

Output data set containing the parameter estimates 
for the trend test.

_pi • Plot Intensities Output data set containing raw intensities and row 
statistics for the input data set.

_plr • SNP Interaction Discovery Output data set containing all of the data from the 
input data set plus three additional columns. These 
include observation number, and two columns list-
ing the predicted values for the dependent class vari-
able.

_plrv • SNP Interaction Discovery Lists the names of the variables selected and used for 
making predictions 

_pls • Partial Least Squares Lists the statistics and associated predictions for each 
of the individuals in the input data set

_plsv • Partial Least Squares Lists the statistics associated with the ability of each 
marker to be used as a predictor for the dependent 
class variable 

_pmd • Population Measures Output symmetric matrix of dissimilarities between 
specified groups within a study

_pmf • Population Measures Output data set listing the individual F-statistics for 
each marker 

_pmo • Population Measures Output data set listing the overall F-statistics for the 
population

_pps • Principal Components 
Analysis for Population 
Stratification

Output data set listing each of the markers with 
selected annotation data and the resulting probabili-
ties the markers are associated with the disease trait, 
given population stratification

JMP Genomics Files have suffixes: Identification of output files by suffix, AP, and contents.
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_pnm • Effect Removal via PLS 
Normalization

• Partial Least Squares 
Normalization

Output data set with the same structure as the input 
data set but with normalized response variables

_prs • Relationship Matrix Output data set listing pairs of samples having an 
identical-by-descent value exceeding a specified 
threshold.

_psc • Phenotype Summary Output data set containing counts for categorical 
variables

_psq • Phenotype Summary Output data set containing counts for quantitative 
variables

_ptr • Partition Trees Output data set listing the input data that has been 
recursively partitioned to optimal splitting relation-
ships as determined by the specified dependent and 
predictor variables

_ptrv • Partition Trees Lists the names of the variables selected and used for 
making predictions

_pva • P-Value Adjustment Output data set containing the columns in the input 
data set with four additional columns listing the 
adjusted p-values for each set of observations

_pvb • P-Value Browser Output data set containing the columns in the input 
data set with four additional columns listing the 
adjusted p-values for each set of observations

_pvc • Correlation and Principal 
Components

Output data set containing the variance within each 
of the principal components that can be attributed to 
each of the variance components

_qcbp • Exon and Whole Transcript 
Expression CEL

Output data set that is used to create a pseudoimage 
of the arrays

_qkm • Q-K Mixed Model Output data set containing association test statistics 
and .jsl file for plotting p-values

_qnm • Quantile Normalization Output data set containing the quantile normalized 
data

_qnp • Quantile Normalization Output data set containing the quantile normalized 
data along with relative rank of each observation and 
residual data

JMP Genomics Files have suffixes: Identification of output files by suffix, AP, and contents.

File Suffix APs Generating the File Function/Contents of the File
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_qtdt • Quantitative TDT Output data set containing Q-TDT test statistics 
and .jsl file for plotting p-values

_rai • Ratio Analysis Output data set containing the log intensities of the 
input data

_rar • Ratio Analysis Output data set containing the log ratio of the 
two-channel input data

_rbm • Radial Basis Machine Lists the statistics and associated predictions for each 
of the individuals in the input data set

_rbmv • Radial Basis Machine Lists the names of the variables selected and used for 
making predictions 

_rm • Relationship Matrix Data set containing the root matrix as computed by 
single value decomposition (SVD) appended to the 
input data set.

_s2b • 2D Bin Output data set containing the binned values for 
each variable

_s2d • 2D Detrend Output data set containing the baseline-adjusted and 
corrected values

_s2p • 2D Peakfind Output data set identifying each peak found in each 
trace

s2p_det • 2D Peakfind Output data set providing specific information 
(upper and lower boundaries, height, area, for exam-
ple) for each peak identified in each trace

_s2g • 2D Plot Output data set listing trimmed input values

_s3a • 3D Align Output data set listing the X and Y coordinates for 
each row with the Z values for each sample listed in a 
separate column

_s3g • 3D Plot Output data set listing the X and Y coordinates for 
each row with the Z values for each sample listed in a 
separate column

JMP Genomics Files have suffixes: Identification of output files by suffix, AP, and contents.
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_sbg • Case-Control Association
• PCA for Population 

Stratification
• Marker-Trait Association
• SNP-Trait Association
• Imputed SNP-Trait 

Association
• Survey SNP-Trait 

Association
• Q-K Mixed Model
• Quantitative TDT
• TDT

Output data set listing the number of significant 
markers for the selected association tests.

_sdp • Affymetrix Cytogenetics 
CHP Input Engine

Output data set 

_seq • Affymetrix Tiling CEL Input 
Engine

Output sequence data set

_sfs • Surface Summary Output data set containing the estimated surface

_sgc • Affymetrix Cytogenetics 
CHP Input Engine

Output data set 

_sgl • Affymetrix Cytogenetics 
CHP Input Engine

Output data set 

_smc • Affymetrix Cytogenetics 
CHP Input Engine

Output data set 

_snl • Affymetrix Cytogenetics 
CHP Input Engine

Output data set 

_sp •  Exon and Whole 
Transcript Expression CEL

Output data set which lists single-probes not associ-
ated to any probe set

_spmm • Survival Predictive 
Modeling

Output data set listing mean survival times

_spms • Survival Predictive 
Modeling

Output data set listing survival functions corre-
sponding to the training data set

_spmt • Survival Predictive 
Modeling

Output data set listing survival functions corre-
sponding to the test data set

_spmv • Survival Predictive 
Modeling

Output data set listing the effects applied in the Cox 
model

JMP Genomics Files have suffixes: Identification of output files by suffix, AP, and contents.
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_sps • Exon and Whole Transcript 
Expression CEL

Output data set which lists single-probe-sets not 
associated to any transcript cluster

_sr • Subset/Reorder Genetics 
Data

The output data set resulting from the reordering/
removal of markers or individuals from either a geno-
type or annotation data set

_sst • Survey SNP-Trait 
Association

Output data set association test statistics 

_sta • SNP-Trait Association Output data set containing association test statistics 
and .jsl file for plotting p-values

_std • Data Standardize Output data set with the same structure as the input 
data set but response variable values that have been 
standardized using one or more different methods

_stk • Stack Output stacked data set

_sva • Survival Analysis Output data set listing survival statistics

_svd • Calculate Square Root of 
Matrix

Output data set 

_tal • Transpose Tall and Wide
• Unstack

The tall data set resulting from either the transposi-
tion of a wide data set or the unstacking of a stacked 
data set. Note: These processes also generate an asso-
ciated EDDS

_tdt • TDT Output data set containing TDT statistics and .jsl 
file for plotting p-values

_tdtt • TDT Output data set containing a pair of allelic transmis-
sion scores for each individual at each marker locus.

_tst • Correlation and Principal 
Components

• Cross Correlation

Output data test data set containing the p-values for 
the test that the correlation equals zero

_vc • Correlation and Principal 
Components

• Batch Normalization

Output data set containing variance component esti-
mates computed from the principal components

JMP Genomics Files have suffixes: Identification of output files by suffix, AP, and contents.

File Suffix APs Generating the File Function/Contents of the File



78 JMP Genomics Files Are Identified by Suffixes Chapter 7

_vcp • Variance Components Output data set listing each of the markers with 
selected statistics for the chi-square statistics and 
p-values for the likelihood ratio test or the z-scores 
and p-values for the Wald test that test for linkage 
between each marker and the quantitative trait

_vg • Verify Gender of Samples Output data set listing the genetic sex of the individ-
uals

_wid • Transpose Tall and WIde The wide data set resulting from the transposition of 
a tall data set

_z • Surface Summary Output coordinates data set

JMP Genomics Files have suffixes: Identification of output files by suffix, AP, and contents.
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Chapter 8
JMP Genomics Processes Call SAS PROCS

JMP Genomics makes extensive use of SAS routines (called PROCs) in order to carry out all of its dif-
ferent functions and analyses. The table below lists the PROCs called by each process. It does not 
include the following PROCs, which are called extensively by every process: CONTENTS, 
DATASETS, EXPORT, MEANS, PRINT, REGISTRY, SORT, and TRANSPOSE. Processes are listed 
alphabetically.

JMP Genomics APs Call SAS PROCs

Process SAS PROCs Called

ABI Analyst Input Engine APPEND, IMPORT, SQL, STDIZE

Affected Sib-Pair Tests ALLELE, APPEND, FORMAT, PSMOOTH

Affymetrix Annotation CSV Files IMPORT

Affymetrix CNAT Input Engine APPEND, IMPORT, SQL, STDIZE

Affymetrix CN CHP Input Engine APPEND, IMPORT, SQL, STDIZE

Affymetrix Cytogenetics CEL 
Input Engine

APPEND, FORMAT, G3D, IMPORT, KDE, LOESS, REG, 
SQL, STDIZE, SURVEYSELECT, UNIVARIATE

Affymetrix Cytogenetics CEL 
Input Engine

APPEND, IMPORT, SQL, STDIZE

Affymetrix Exon and Whole 
Transcript Expression CEL Input 
Engine 

APPEND, FORMAT, G3D, IMPORT, KDE, SQL, STDIZE, 
UNIVARIATE

Affymetrix Expression CEL Input 
Engine

APPEND, FORMAT, G3D, IMPORT, KDE, SQL, STDIZE, 
UNIVARIATE

Affymetrix Expression CHP Input 
Engine

APPEND

Affymetrix miRNA CEL Input 
Engine

APPEND, FORMAT, G3D, IMPORT, KDE, LOESS, REG, 
SQL, STDIZE, SURVEYSELECT, UNIVARIATE

Affymetrix SNP CEL Input 
Engine

APPEND, FORMAT, G3D, IMPORT, KDE, SQL, STDIZE, 
UNIVARIATE
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Affymetrix SNP CHP Input 
Engine

APPEND, IMPORT, SQL, STDIZE

Affymetrix Tiling Bar Input 
Engine

IMPORT

Affymetrix Tiling CEL Input 
Engine

IMPORT

Agilent Input Engine APPEND, IMPORT, SQL, STDIZE

Allele Specific Expression Filter MULTTEST, REG, 

ANOVA APPEND, MIXED, MULTTEST, STDIZE, TPSPLINE, 
UNIVARIATE

ANOVA Normalization APPEND, MIXED, MULTTEST, STDIZE, TPSPLINE, 
UNIVARIATE

Append APPEND

ArrayTrack Input Engine APPEND, IMPORT, SQL, STDIZE

Batch Normalization FASTCLUS, GCHART, GPLOT,MIXED, PRINCOMP

Batch Scoring UNIVARIATE

Bin (Copy Number) This process calls no additional SAS PROCs

Bin Intensities or Read Counts This process calls no additional SAS PROCs

Bioconductor Expresso for 
Affymetrix

APPEND, IMPORT, SQL, STDIZE

Bivariate One-Way ANOVA APPEND, MIXED, MULTTEST, STDIZE, TPSPLINE, 
UNIVARIATE

Build Genotype Probability Data 
Set

IML, REG, SUMMARY

Calculate Square Root of Matrix IML

Case-Control Association ALLELE, APPEND, CASECONTROL, FORMAT, 
MULTTEST, PSMOOTH

Change Labels RANK

Chromosome Color Theme This process calls no additional SAS PROCs

Column Enrichment APPEND, FREQ, GLMMOD, MULTTEST, RANK, 
TPSPLINE

JMP Genomics APs Call SAS PROCs

Process SAS PROCs Called
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Combine Columns This process calls no additional SAS PROCs

Combine Experiments This process calls no additional SAS PROCs

Control Set Normalization This process calls no additional SAS PROCs

Copy Number/LOH COntrol Set 
Adjustment

This process calls no additional SAS PROCs

Correlation and Grouped 
Scatterplots

SURVEYSELECT

Correlation and Principal 
Components

CORR, FACTOR, GCHART, GPLOT, MIXED, PRINCOMP

Create Annotation Analysis 
Group Variable

This process calls no additional SAS PROCs

Cross Correlation APPEND, CORR

Data Filter CORR, MIXED, MULTTEST

Data Standardize STDIZE, UNIVARIATE

Difference Chooser MIXED

Distribution Analysis KDE

Discriminant Analysis APPEND, CATALOG, CORR, DISCRIM, FASTCLUS, 
FREQ, GLIMMIX, GLMMOD, IML, LOGISTIC, MIXED, 
MULTTEST, NPAR1WAY, RANK, REG, ROBUSTREG, 
SQL, STDIZE, STEPDISC, TPSPLINE, TTEST, 
UNIVARIATE

Distance Matrix CLUSTER, DISTANCE, TREE

Distance Scoring APPEND, CATALOG, CORR, DISCRIM, DISTANCE, 
FASTCLUS, FREQ, GLIMMIX, GLMMOD, IML, 
LOGISTIC, MIXED, MULTTEST, NPAR1WAY, RANK, 
REG, ROBUSTREG, SQL, STDIZE, STEPDISC, 
TPSPLINE, TTEST, UNIVARIATE

Estimate Builder MIXED

Experimental Design File Builder OPTIONS

Export to GSEA Format FREQ

Factor Analysis Normalization FACTOR

Feature Flagger FREQ, REPORT

JMP Genomics APs Call SAS PROCs

Process SAS PROCs Called
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Filter Intensities UNIVARIATE

Gene Model Summary This process calls no additional SAS PROCs

Gene Set Enrichment FREQ, GLMMOD, MULTTEST, RANK, SQL

GenePix Input Engine APPEND, IMPORT, SQL, STDIZE

General Linear Model Selection APPEND, CATALOG, CORR, DISCRIM, DISTANCE, 
FASTCLUS, FREQ, GLIMMIX, GLMMOD, GLMSELECT, 
IML, LOGISTIC, MIXED, MULTTEST, NPAR1WAY, RANK, 
REG, ROBUSTREG, SQL, STDIZE, STEPDISC, 
TPSPLINE, TTEST, UNIVARIATE

Haplotype Estimation ALLELE, APPEND, FORMAT, HAPLOTYPE, PSMOOTH

Haplotype Trend Regression GLM, GLIMMIX, HAPLOTYPE, LOGISTIC, MULTTEST, 
PHREG, REG

HapMap Input Engine IMPORT

Haseman-Elston Regression ALLELE, APPEND, FORMAT, MIXED, PSMOOTH

htSNP Selection ALLELE, APPEND, FORMAT, HTSNP, PSMOOTH

Illumina CN Input Engine APPEND, IMPORT, SQL, STDIZE

Illumina Expression Input Engine APPEND, IMPORT, SQL, STDIZE

Illumina miRNA Imput Engine APPEND, IMPORT, KDE, LOESS, REG, SQL, STDIZE, 
SURVEYSELECT, UNIVARIATE

Illumina SNP Input Engine APPEND, IMPORT, SQL, STDIZE

IM and CIM Analysis IML, REG, REPORT, SUMMARY

Import a Designed Experiment 
from Text, CSV or Excel Files

APPEND, IMPORT, SQL, STDIZE

Import Individual Text, CSV or 
Excel Files

APPEND, IMPORT, SQL, STDIZE

Imputed SNP (Tall Format) Input 
Engine

IMPORT

Imputed SNP-Trait Association ALLELE, FORMAT, GLIMMIX, LOGISTIC, MIXED, 
PHREG, PSMOOTH, SURVEYFREQ

Imputed SNP (Wide Format) 
Input Engine

IMPORT

K Matrix Compression CLUSTER, IML, MIXED, SQL, TREE

JMP Genomics APs Call SAS PROCs

Process SAS PROCs Called
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K-Means Clustering FASTCLUS

K Nearest Neighbors APPEND, CATALOG, CORR, DISCRIM, DISTANCE, 
FASTCLUS, FREQ, GLIMMIX, GLMMOD, IML, 
LOGISTIC, MIXED, MULTTEST, NPAR1WAY, RANK, 
REG, ROBUSTREG, SQL, STDIZE, STEPDISC, 
TPSPLINE, TTEST, UNIVARIATE

KEGG Pathway Color UNIVARIATE

Kinship Matrix IML, INBREED

LD Block Creation ALLELE, IML

LD tagSNP Selection ALLELE, APPEND, FORMAT, IML, PSMOOTH

Linkage Disequilibrium ALLELE, APPEND, FORMAT, PSMOOTH

List Enrichment FREQ, IMPORT, SQL

Loess Normalization LOESS

Logistic Regression APPEND, CATALOG, CORR, DISCRIM, DISTANCE, 
FASTCLUS, FREQ, GENESELECT, GLIMMIX, GLMMOD, 
IML, LOGISTIC, MIXED, MULTTEST, NPAR1WAY, RANK, 
REG, ROBUSTREG, SQL, STDIZE, STEPDISC, 
TPSPLINE, TTEST, UNIVARIATE

Malecot LD Map ALLELE, APPEND, FORMAT, NLMIXED, PSMOOTH

MANOVA APPEND, MIXED, MULTTEST, STDIZE, TPSPLINE, 
UNIVARIATE

Marker Properties ALLELE, FORMAT, PSMOOTH

Marker-Trait Association ALLELE, APPEND, FORMAT, GLIMMIX, LOGISTIC, 
MIXED, PHREG, PSMOOTH 

Merge SQL

Merge Gene Sets IMPORT, SQL

Missing Genotypes by Trait 
Summary

ALLELE, APPEND, CASECONTROL, FORMAT, 
PSMOOTH

Mixed Model Analysis APPEND, MIXED, MULTTEST, STDIZE, TPSPLINE, 
UNIVARIATE

Mixed Model Normalization APPEND, MIXED, MULTTEST, STDIZE, TPSPLINE, 
UNIVARIATE

Mixed Model Power MIXED

JMP Genomics APs Call SAS PROCs

Process SAS PROCs Called
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Multidimensional Scaling APPEND, MDS

Multiple SNP-Trait Association GLIMMIX, GLM, LOGISTIC, MIXED, PHREG, 
PRINCOMP, PSMOOTH

One-Way ANOVA APPEND, MIXED, MULTTEST, STDIZE, TPSPLINE, 
UNIVARIATE

Parse a Column This process is a .jsl script and calls no SAS PROCs

Partial Least Squares APPEND, CATALOG, CORR, DISCRIM, DISTANCE, 
FASTCLUS, FREQ, GLIMMIX, GLMMOD, IML, 
LOGISTIC, MIXED, MULTTEST, NPAR1WAY, PLS, RANK, 
REG, ROBUSTREG, SQL, STDIZE, STEPDISC, 
TPSPLINE, TTEST, UNIVARIATE

Partial Least Squares 
Normalization

GLMMOD, PLS

Partition (Copy Number ) FREQ, GENESELECT, SQL

Partition Trees APPEND, CATALOG, CORR, DISCRIM, DISTANCE, 
FASTCLUS, FREQ, GENESELECT, GLIMMIX, GLMMOD, 
IML, LOGISTIC, MIXED, MULTTEST, NPAR1WAY, RANK, 
REG, ROBUSTREG, SQL, STDIZE, STEPDISC, 
TPSPLINE, TTEST, UNIVARIATE

PCA for Population Stratification ALLELE, APPEND, CORR, FORMAT, GLMMOD, IML, 
PLS, PRINCOMP, PSMOOTH, STDIZE, SUMMARY

Pleiotrophic Association ALLELE, GLM, PSMOOTH

PLINK Input Engine APPEND, IMPORT, SQL, STDIZE

P-Value Adjustment APPEND, MIXED, MULTTEST, STDIZE, TPSPLINE, 
UNIVARIATE

P-Value Browser APPEND, FORMAT, MULTTEST, PSMOOTH, TPSPLINE

P-Value Combination This process calls no additional SAS PROCs

Pedigree Input Engine APPEND, IMPORT, SQL, STDIZE

Phenotype Summary FREQ

Population Genetic Distance ALLELE, APPEND, FORMAT, PSMOOTH

Population Measures ALLELE, APPEND, FORMAT, PSMOOTH

Principal Components Analysis APPEND, GLMMOD, PLS, PRINCOMP, STDIZE, 
SUMMARY

JMP Genomics APs Call SAS PROCs

Process SAS PROCs Called
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Principal Component Scoring IML, PLS

PseudoImage APPEND, STDIZE, UNIVARIATE

Q-K Mixed Model ALLELE, FORMAT, GLIMMIX, LOGISTIC, MIXED, 
PSMOOTH,SURVEYFREQ

QuantArray Input Engine APPEND, IMPORT, SQL, STDIZE

Quantitative TDT ALLELE, APPEND, FAMILY, FORMAT, GLM, IML, 
INBREED, MIXED, PSMOOTH, UNIVARIATE

Radial Basis Machine APPEND, CATALOG, CORR, DISCRIM, DISTANCE, 
FASTCLUS, FREQ, GLIMMIX, GLMMOD, IML, 
LOGISTIC, MIXED, MULTTEST, NPAR1WAY, RANK, 
REG, ROBUSTREG, SQL, STDIZE, STEPDISC, 
TPSPLINE, TTEST, UNIVARIATE

Rank Rows RANK

Ratio Analysis LOESS

Recode Genotypes ALLELE, APPEND, FORMAT, PSMOOTH

Recode Missing Genotypes This process calls no additional SAS PROCs

Relationship Matrix CORR, DISTANCE, IML, PRINCOMP

Reorder APPEND

SAM Input Engine IMPORT, APPEND,SQL

SNP Interaction Discovery APPEND, CATALOG, CORR, DISCRIM, DISTANCE, 
FASTCLUS, FREQ, GENESELECT, GLIMMIX, GLMMOD, 
IML, LOGISTIC, MIXED, MULTEST, NPAR1WAY, RANK, 
REG, ROBUSTREG, SQL, STDIZE, STEPDISC, 
TPSPLINE, TTEST, UNIVARIATE

SNP Power IML

SNP-SNP Interactions FORMAT, GLIMMIX, LOGISTIC, MIXED, PHREG, 
PSMOOTH, SQL

SNP-Trait Association ALLELE, APPEND, FORMAT, GLIMMIX, LOGISTIC, 
MIXED, PHREG, PSMOOTH

ScanAlyze Input Engine APPEND, IMPORT, SQL, STDIZE

Single Marker Analysis IML, REG, REPORT, SUMMARY

Spectral 2D Peak Find IML

JMP Genomics APs Call SAS PROCs

Process SAS PROCs Called
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Spectral 3D Align KDE

Spectral 3D Plot SPECTRVIEW

Split Experiments This process calls no additional SAS PROCs

Statistics for Columns SUMMARY

Subset and Reorder Genetic 
Data

ALLELE, APPEND, FORMAT, PSMOOTH

Surface Summary FORMAT, G3D, KDE, UNIVARIATE

Survey SNP-Trait Association ALLELE, APPEND, FORMAT, PSMOOTH, SURVEYFREQ, 
SURVEYLOGIC, SURVEYREG

Survival Analysis APPEND, MULTTEST, PHREG, TPSPLINE

Survival Predictive Modeling PHREG, MULTTEST

TDT ALLELE, APPEND, FAMILY, FORMAT, PSMOOTH

Track BAR Chart This process calls no additional SAS PROCs

Track Gene GFF This process calls no additional SAS PROCs

Track Gene Text This process calls no additional SAS PROCs

Track Gene Web This process is a .jsl script and calls no SAS PROCs

Track SNP Web This process is a .jsl script and calls no SAS PROCs

Two-Way Plotter GCHART, GPLOT, GREPLAY

Variance Components ALLELE, APPEND, FORMAT, IML, INBREED, MIXED, 
PSMOOTH, UNIVARIATE

Verify Gender of Samples This process calls no additional SAS PROCs

JMP Genomics APs Call SAS PROCs

Process SAS PROCs Called



Chapter 9
Troubleshooting

This troubleshooting guide can help you diagnose and resolve problems that you may encounter when 
running JMP Genomics. If problems persist after troubleshooting, contact JMP Technical Support at 
support@jmp.com. Select Genomics > Documentation and Help > Contacting Technical Sup-
port, in JMP, for additional information. 

Process Problem Suggested Cause/Resolution

Installation of
JMP Genomics

The message: Ex-
isting Client Found
is displayed in the
Install Shield Wiz-
ard window, indi-
cating that a
preexisting copy of
SAS has been
found on a net-
work server. 

A pre-existing copy of SAS has been found that is configured to
run as a thin Client from a network server. JMP Genomics will
only work with a personal copy of SAS loaded on the same Client
machine and configured to work locally.
Contact JMP Technical Support (support@jmp.com) for instruc-
tions and assistance in resolving this problem. Select Genomics >
Documentation and Help > Contacting Technical Support,
in JMP, for additional information.
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Opening JMP
Genomics

A message appears
stating that your
license has ex-
pired.

Your license to run JMP Genomics software has expired. You
must obtain updated license files to renew your license. 
You will need two license files for JMP Genomics: one to update
the JMP license and one to update the SAS license. Most likely,
you will have received these files in an e-mail. If not, send an
e-mail to support@jmp.com to request updated license files.
The license files must be saved to your local hard drive.
To update the JMP license, complete the following steps:

1 Start JMP.

2 JMP will open a dialog asking if you want to update your 
license. Click Yes to open the license renewal tool.

3 Click Open License.

4 Browse to the folder in which you saved the license files and 
click Open.

To update the SAS license, complete the following steps:

1 Click Start > Programs > SAS > SAS 9.2 License 
Renewal & Utilities > Renew SAS Software to open the 
renewal tool.

2 Browse to the folder in which you saved the license files and 
click OK.

3 When prompted click Renew.

4 Click OK in the confirmation window.

Moving data
between JMP
Genomics (32
bit) and JMP
Genomics (64
bit)

Processes take sig-
nificantly more
time to run than
previously ob-
served.

Apply the hot fix found at http://ftp.sas.com/techsup/download/
hotfix/HF2/B25.html#B25026.

Any process in
using SAS
DATA com-
posed in Mi-
crosoft Word
and pasted into
JMP Genomics

A syntax error is
displayed.

Microsoft Word uses a Smart Quote feature that converts quota-
tion marks from the format needed by SAS into a format more ap-
propriate for English language text. 
SAS DATA step commands should either be composed in a simple
text editor and then pasted into the JMP Genomics DATA Step
input fields or directly in the DATA Step input fields. DATA Step
commands should never be composed using Microsoft Word.

Process Problem Suggested Cause/Resolution

http://ftp.sas.com/techsup/download/hotfix/HF2/B25.html#B25026

http://ftp.sas.com/techsup/download/hotfix/HF2/B25.html#B25026
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Any JMP Ge-
nomics process
that uses one or
more SAS pro-
grams
Any JMP Ge-
nomics process
that uses one or
more SAS pro-
grams

A SAS log is dis-
played in your
JMP Genomics
session along with
a message preced-
ed by ERROR.

The generated SAS code might not complete successfully because
of mis-specified parameters.
Most of the error messages should be self-explanatory and provide
some idea about what to do next. If not, examine the broader con-
text provided by the SAS log to determine the problem. If this
fails, consult and search the SAS documentation for the SAS code
generating the error by clicking Help > SAS Documentation -
Local or Help > SAS Documentation - Web.
There is also the possibility of a bug in the SAS macro code. If you
have found what appears to be a bug, please send the SAS log and
explanation to support@jmp.com. Please describe your procedure
in sufficient detail for us to reproduce the problem. If you are a
SAS programmer, you might wish to view and even edit the orig-
inal SAS code in the ProcessLibrary and/or MacroLib folders.
Please also feel free to send suggested changes to the code to sup-
port@jmp.com.

A WARNING dia-
log appears, telling
you that SAS is
connected and a
process is already
running. 

JMP Genomics can only run one process at a time and does not
queue jobs. Click OK in the dialog to wait, disregard the second
Run, and let the current process continue running. Click View
Log to view the current SAS log to get information about the cur-
rent process. Click Stop to stop the current process. If the SAS
process does not stop in a short period of time, it is okay to kill the
sas.exe process directly from Windows Task Manager, and then
click Stop again.

A process runs
longer than ex-
pected or produces
no output.

In this situation, perform the following steps:

1 Click Run again. A WARNING: SAS is Connected window 
should appear.

2 Click View Log. If any SAS ERROR messages appear, click 
Stop to stop the current process. If not, proceed to the step 
below.

3 View the SAS log that is displayed in the JMP Log window to 
see the most recently executed code. You can continue to click 
View Log as many times as you like to check the status of the 
SAS program. Alternatively, you can monitor generated file 
activity in the SAS working folder. To open this folder while 
the analysis is running, click Open SAS Temporary Folder. 
You should see various files being generated as the process 
runs. On Windows, press F5 to refresh the folder while you 
are monitoring it.

If these steps do not help, try running the process in the SAS 9.2
Display Manager as described below.

Process Problem Suggested Cause/Resolution
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Any JMP Ge-
nomics process

Output of the pro-
cess does not auto-
matically open.

The output filename might contain the following characters: (),
@, ^ and &, any place of output name, or contains [] at the begin-
ning of the name, (such as [name], for example). 
If these characters are present, you can open the output by com-
pleting the following steps: 

1 Navigate to the specified output folder. 

2 Double-click on the sasclean.jsl script in the folder. 

All of the output should open.

Processes that
perform repeti-
tive computa-
tions

The SAS log is too
long and is trun-
cated.

In either of these cases, an alternative way to debug the process is
to open the .sas file in the SAS 9.2 Display Manager (right-click
and select Open with SAS 9.2) and run it from there by pressing
F3. The SAS Display Manager provides options for saving or de-
leting sections of long logs. On Windows operating systems, you
can alternatively right-click on a .sas file and select Submit to
SAS 9.2.
SAS will then run in batch mode and produce .log and .lst files.

Processes that
specify a lot of
variables into
one macro

The line length
can become too
long for SAS batch
mode.

Processes using
wide data sets
composed of
long lists of
variables

Numerous
ERROR messages
are generated in
the SAS log.

The SAS Macro text expression limit of 65534 bytes might have
been exceeded.
Work-arounds for this situation include the following:

1 Recreate the data set or rename the variables to have the short-
est possible names.

2 Modify the process specification to have list-style input for 
long lists of variables, such as Col1-Col20000.

3 Reduce the number of variables using K-Means Clustering, as 
follows. Transpose the data to tall form using Transpose 
Rectangular, run K-Means Clustering to generate a few thou-
sand or less clusters, retain representatives from each cluster to 
use as the data, and then transpose back to wide form using 
Transpose Rectangular.

Process Problem Suggested Cause/Resolution
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Opening a data
file using the
File > Open
command in
any JMP Ge-
nomics process

The column
names listed in the
Available
Variables box of a
dialog appear dif-
ferent than the
original column
names in the data
set.

SAS uses two ways to name a column: the variable label and the
variable name. When a file is opened using the File > Open com-
mand from the JMP menu, SAS variable labels will be displayed.
These might differ from those displayed in the Available Variables
list in the JMP Genomics process dialogs, which display SAS vari-
able names for the available variables.
To solve the problem, open the data file using the Open button
on the process dialogs. This displays the table with names the same
as those in the Available Variables lists. 
Alternatively, use the File > Open command from the JMP menu
and, in the Open Data File dialog, change File of type to SAS
Data Sets and click the Use SAS Variable Names for Column
Names check box.

Affymetrix
Expression
CHP Input En-
gine

An ERROR mes-
sage, indicating
that the specified
EDF does not ex-
ist, is generated.

This message has been observed when an .xls file has been speci-
fied as the EDF if either the EDF is open in Excel or has been
saved using a legacy (Excel 4.0 or older) format. To resolve this
problem, first make sure the file is not open. Second, open the file
in Excel and save it in the most recent format. Alternatively, open
the file in JMP and save it as a SAS data set using the command
File > Save As SAS Data Set.

Affymetrix
Expression
CEL Input En-
gine

An ERROR mes-
sage is displayed
stating: The
macro vari-
able name is
either all
blank or
missing.

Files selected on the Library Files tab have been mis-specified. Re-
view your selections and correct as needed.

Agilent Import
Engine

Running the pro-
cess generates a
long ERROR mes-
sage along with a
SAS Log and a
SAS Message di-
alog indicating the
successful genera-
tion of the SAS
Data Set, EDDS
and an Annotation
data set.

The process has run successfully despite the appearance of the
ERROR message. The likely cause of the ERROR message is the
presence of non-numeric character strings in numerical columns.
For example, Agilent places the string #IND, in empty numeric
cells to indicate missing values. When SAS imports the data from
these files, it reports an error and replaces the character string with
a period (.). 
Open the resulting data sets to verify they are as you intended. If
so, you can safely ignore the ERROR message and proceed with
the data analysis.

Process Problem Suggested Cause/Resolution
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Bioconductor
Expresso for
Affymetrix Im-
port Engine

An ERROR mes-
sage is generated
when you try to
choose an input
data set using the
Universal/
Uniform Naming
Convention
(UNC).

The Bioconductor Expresso wrapper does not accept the Univer-
sal/Uniform Naming Convention (UNC) for describing the loca-
tion of a volume, directory or file. The UNC format is
(\\directory\subdirectory\file). 
To avoid using a UNC formatted path, do not begin navigating to
the desired files/folders by clicking on the directories shown in the
box on the left side of the Open Data File window, as this will for-
mat the resulting path in the UNC. Instead, begin navigating by
clicking within the Look in: box at the top of the window. The for-
mat of the resulting path (C:\Directory\Subdirectory\file) is ac-
ceptable to the Bioconductor Expresso process.

Any input en-
gine

An ERROR mes-
sage is generated
when you try to
use an EDF gener-
ated by the EDF
Builder and saved
as a text file.

JMPs Text Data File default Import setting for the End of Field is
set to Tab and Comma and the export settings preference for the
End of Field is set to Comma. If the EDF is saved as a .txt file and
the fields end with commas instead of tabs, the format of the EDF
is not recognized by the input engines.
JMP Genomics' default Import and Export should both be set to
Tab.

A long ERROR
message beginning
with ERROR:
Limit set by
ERRORS= op-
tion
reached.
Further er-
rors of this
type will
not be
printed. 

This message is generated when the numeric column containing
one or more character strings such as three hyphens (---) or N/
A to represent missing data. 
In many cases, the resulting data set is successfully generated.
However, the heading associated with the columns might not be
positioned in the correct columns. You should verify that each col-
umn contains the appropriate heading. 

Process Problem Suggested Cause/Resolution
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Import
Individual Txt,
CSV or Excel
Files Input En-
gine

Genotypes in the
input files whose
alleles are delimit-
ed using a "/" are
misrepresented as
date/time data.

You should check the initial data format before importing the da-
ta. Select File > Open. An Open Data File window opens. Select
Text Import Preview from the Files of Type drop-down menu
and click Open. Count the columns listing information and the
columns listing SNP genotypes.
Define information about the number of non-marker columns
and the number of marker columns as follows:

Complete the General and Option tabs of the dialog, as nor-
mal.

Type Column1-Columnxx (SNP1-SNPyy) ($) in the 
List of Variable Names and Types field on the Wide Data tab 
of the Import Individual Txt, CSV or Excel Files dialog. 

Note: xx indicates the right-most column containing non-marker
information (assumes that marker information begins in columns
xx+1); yy indicates the total number of columns containing mark-
er information.

Run the process as normal.

Note: This fix assumes that your data is in the wide format.

Any Import
process

A SAS log is dis-
played in your
JMP Genomics
session along with
a message preced-
ed by ERROR or
there are notes in
the SAS log indi-
cating invalid data
for particular vari-
ables.

When importing a file to a SAS data set, SAS determines the type
of variable (character or numeric) based on the first N observa-
tions, where N is the value provided in the Number of Rows to
Scan parameter on the Options tab of most of the 
Import processes.  Sometimes, when a character value is present af-
ter the first N observations and the previous observations have all
been numeric (so that the variable has already been defined as nu-
meric), an error occurs when SAS attempts to read this character
value.  
Try increasing the value for N in the Options tab until you no
longer see these notes in the log.

The values in one
or more columns
are truncated. 

When importing a file to a SAS data set, SAS determines the
length of variable (character or numeric) based on the first N ob-
servations, where N is the value provided in the Number of Rows
to Scan parameter on the Options tab of most of the Import pro-
cesses. Sometimes, when subsequent values are longer than those
in the first N observations, SAS will truncate those values to the
length determined for the N observations.
Try increasing the value for N in the Options tab.

Process Problem Suggested Cause/Resolution
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Learning
Curve Model
Comparison
AP

No results dis-
played, no SAS er-
ror shown, but an
error in the JMP
log, such as:
Unable to
open in Rea-
dOnly mode. 
The system
cannot find
the file
specified.
 in access
or evalua-
tion of 'In-
clude',
In-
clude("C:\Pr
ogram
Files\SAS\JM
P9\Genom-
ics\Work-
flowResults\
cvlc_plot.js
l")

SAS Enterprise Miner, can cause PROC GENESELECT to end
abnormally. Check to see whether you have SAS Enterprise Miner
installed on your machine. 
To fix the problem, rename C:\Program Files\SAS\SAS
9.2\dmine\sasmsg\dmine.msg and replace it with C:\Program
Files\SAS\SAS 9.2\genetics\sasmsg\dmine.

Process Problem Suggested Cause/Resolution
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KEGG
Pathway
Analysis

An ERROR mes-
sage is generated
stating: You se-
lected to
use proxy
server to
access web,
but did not
specify
proxy server
name or port
number.
Please run
Configure
Proxy Set-
tings to set
the value.

The Proxy Server or Proxy Port number could have been incor-
rectly specified.

Note: A proxy server is a server that sits between a Web browser 
and an external server on the Web to filter requests, improve per-
formance, and share connections. If your computer accesses the 
Internet through a proxy server, you must reset your proxy name 
and port number before you run the KEGG Pathway Analysis 
process. 

Run the File > Configure Genomics Settings process as 
described in Configuring JMP Genomics Settings. Make sure the 
correct name and number are entered in the dialog and click Run 
to configure your settings.

An ERROR mes-
sage is generated
stating: ERROR:
KEGG throws
RemoteExcep-
tion when
searching
pathways for
hsa04520.
Please refer
to the Java
log for fur-
ther de-
tails.

The KEGG API server is either down, very busy, or the connec-
tion to the KEGG API server is denied.
Retry the process at another time.

KEGG
Pathway
Analysis AP

An ERROR mes-
sage is generated
stating: 
ERROR:
Failed to
find genom-
ics.config
file.

Check to see whether the genomics.config file is missing from the
<sasroot>\sds\sasmisc directory (the default <sasroot> is
C:\Program Files\SAS\SAS SASFoundation\9.2). 
If the config file is missing, reinstall your JMP Genomics. The in-
stall copies this configuration file to: 
C:\Program Files\SAS\SAS SASFoundation\9.2\sds\sasmisc.

Process Problem Suggested Cause/Resolution
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Any Workflow
AP

Attempts to run a
second AP or new
Workflow fails.
The JMP Log
shows the follow-
ing message: A
second
script is
attempting
to execute,
possibly
during a
nested click
event. It
may be nec-
essary to
press Escape
to terminate
the previous
script.

Press Esc to exit the JMP Script.

Saving a JMP
table as an Ex-
cel spreadsheet

The following er-
ror message is sur-
faced:
[Microsoft]
[ODBC Excel
Driver] Can-
not modify
the design
of table
'Abrasion’.
It is in a
read-only
database.

The ODBC setting must be changed using the following proce-
dure:

1 Click Start > Settings > Control Panel. 

2 Double-click Administrative Tools. 

3 Double-click Data Sources(ODBC) to open the ODBC Data 
Source Administrator dialog. 

4 Select Excel Files in the Use Data Sources panel and click 
Configure... to open the ODBC Microsoft Excel Setup dia-
log.

5 Click Options and uncheck the Read Only check box.

6 Click OK on the open dialogs.

Process Problem Suggested Cause/Resolution
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Definitions/Explanations of Terms Used in JMP Genomics Documentation

Term Definition/Explanation

Accession Number Numerical identifier for a gene, marker, or gene product in a public data 
base 

Allele Any variant form of a nucleic acid sequence or marker at a particular locus

Alpha Significance level. While alpha can be any value between 0 and 1, it is typ-
ically set at either 0.01, 0.05 or 0.10.

Annotation Data 
Set

Data set containing a variety of information on the identity, biological 
function, pathway association, etc., for the genes, gene fragments, gene 
products, probe sets, genetic markers, etc., under investigation.

Association The statistically significant co-occurrence of two or more phenomena. In 
the context of genome-wide association studies (GWAS), mapping of a 
gene for a particular trait or disease is performed by detecting significant 
associations between the trait and marker genotype.

AUC Area under the receiver operating curve (ROC) statistic that is used to 
assess the ability of a model to predict future responses. For most models, 
the greater the AUC, the better the model is for making accurate predic-
tions. 

Bin A group of related of functionally similar observations that are considered 
as a unit for statistical analysis.

Binary Variable A variable that contains two discrete values, for example, 0 and 1.

Bivariate Involving two variables.

Bootstrap The practice of using with-replacement empirical distribution of observa-
tions to estimate the statistical properties of the population from which the 
observations were made. 
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Box Plot Used to display the response distribution at different combinations of fac-
tor levels. Box plots can reveal differences in the response mean at different 
levels, suggesting main effects. Box plots can also reveal whether the 
response variation is homogenous across factor levels, an assumption made 
in analysis of variance.

BY Group All of the observations with the same values for all BY variables.

BY Variable An optional (in most APs) variable specification whose values define 
groups of observations, such as hour, month, or year. Specifying a BY vari-
able allows you to animate an image so that you can see how response val-
ues change according to some grouping, like over time. Alternatively, BY 
variables can enable analyses to be performed separately on different groups 
as defined by a variable such as gender.

Cell Plot  A heat map or color map display, mapping colors to values of variables and 
displaying them in a rectangular grid.

Censor Variable(s) These columns specify those observations for which data have been cen-
sored or truncated. For example, investigations of the effects of certain 
genes on life span may be terminated before all of the individuals have 
expired. The ultimate life spans for these individuals are unknown. All that 
can be said is that they exceed the period of the study. These data are con-
sidered censored. 

CentiMorgan (cM) Also referred to as a map unit. A measure of genetic distance between loci; 
one centimorgan is equivalent to the physical separation between loci 
needed for a recombination frequency of 1%. Recombination between loci 
is affected by a variety of molecular and biochemical factors, in addition to 
physical distance, and the centimorgan should not be considered as repre-
senting a linear measurement.

Character Variable A variable whose values can consist of alphabetic and special characters as 
well as numeric characters

Check Box An item in a dialog or window that you can select without affecting any 
other items. You can deactivate a check box by selecting it again.

Cholesky Decom-
position

A mathematical method for taking the square root of a symmetric matrix.   
The Cholesky root of a matrix A is L, where A = LL`, and L is a lower-tri-
angular matrix. It is useful in QTL analysis because it allows modeling of a 
pedigree-induced covariance structure via a mixed model.

Definitions/Explanations of Terms Used in JMP Genomics Documentation

Term Definition/Explanation



1
0

G
lo

s
s
a
ry

Chapter 10 Glossary 99

Class Variable The variable whose values define the groups for analysis. Class variables can 
have continuous values, but they typically have a few discrete values that 
define the classifications of the variable. Values may either be character or 
numeric.

Clustering The process of dividing a data set into mutually exclusive groups such that 
the observations for each group are as close as possible to one another, and 
different groups are as far as possible from one another.

Color Variable A variable whose values are used to specify how the graphical output of an 
analysis is to be colored

Composite Interval 
Mapping (CIM)

Method for mapping of a target QTL for a trait. It uses markers, located 
elsewhere in the genome, that have previously been shown to be associated 
with additional QTL’s for that trait. Multiple analysis points across each 
inter-locus interval for the target QTL are assessed. 

Copy Number Vari-
ation (CNV)

Any deletion, insertion, duplication or other variant in the DNA sequence 
of a genome that results in that sequence being present in greater or lesser 
numbers relative to those seen in a normal, reference genome. A CNV can 
result from relatively simple duplications, either tandem or inverted, or 
deletion of small or large blocks of sequence. They may also be more com-
plex, involving gains or losses of homologous sequences at multiple sites in 
the genome. Disruption of contiguous gene sequences and altered gene 
dosages by CNVs have been shown to influence gene expression, increase 
phenotypic variation and cause disease.

Covariance A measure of the relationship between two variables. It equals the correla-
tion between the two variables times the square roots of their variances.

Covariate An independent variable, not manipulated by the experimenter, that may 
influence the outcome of the experiment.

Cross Validation A statistical method for evaluating how well a model will predict the out-
come of additional experiments.

Delimiter One or more characters that separate the designations for the different alle-
les in a genotype. JMP Genomics frequently uses a forward-slash (/) as a 
delimiter.

Dependent Variable A variable whose value is determined by the value of another variable or by 
the values of a set of variables. This variable lists the responses you measure. 
In a two-dimensional plot, the dependent variable is usually plotted on the 
y (horizontal) axis.

Definitions/Explanations of Terms Used in JMP Genomics Documentation

Term Definition/Explanation
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Dialog An interactive window that allows you to set parameters for and run an 
analytical process.

Distance Matrix A matrix of distances.

Drill down To start at one level of a dimension hierarchy and to click through one or 
more lower levels until you reach the data that you are interested in.

Eigenvalue A scalar value that determines by how much a corresponding eigenvector is 
scaled by the square matrix for which it is defined. In principal component 
analysis, the eigenvalues of the covariance or correlation matrix represent 
the variance of the components.

Eigenvector For a given square matrix, a non-zero vector that changes length, but not 
direction, when multiplied by the matrix. The computation of principal 
components for a set of variables uses the eigenvectors of the variables' 
covariance or correlation matrix.

ESTIMATE State-
ment

A programming statement for certain SAS procedures (e.g. PROC 
MIXED) used to specify parameters used in both ANOVA and mixed model 
analyses to test an arbitrary set of linear hypotheses regarding the relative 
importance of different combinations of fixed effects parameters.

Exon The portions of the coding region of a gene that make up the mature 
mRNA. Exons are separated in the genomic DNA by intervening 
sequences (introns) that are transcribed with the exons. Introns are excised 
and the exons are spliced together during post-transcriptional processing 
and mRNA maturation.

Expression The process by which the information contained in a gene is used to make 
a functional RNA or protein

Experimental 
Design Data Set 
(EDDS)

An EDDS is a SAS data set that provides information about the columns 
of a tall data set. It describes relevant experimental variables such as treat-
ment conditions and covariates as well as a variable named ColumnName. 
Entries in the ColumnName column must exactly match the column 
names in the input tall data set. EDDSs have certain constraints that must 
be followed for the processes to run successfully. 

An EDDS is required by most processes using a tall input data set. Many of 
the input engines that generate a tall data set from raw data files also auto-
matically generate the needed EDDS.
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Experimental 
Design File (EDF)

A file which provides JMP Genomics with important information about 
how an experiment was carried out. It defines experimental variables such 
as treatment conditions and covariates and provides the basis for organizing 
and analyzing your data. 
An EDF is required by many of the input engines for the construction of a 
SAS data set from the raw data files. An EDF also serves as a precursor to 
the experimental design data set 

Factor Also referred to as an independent or predictor variable, a factor is a vari-
able included in a model to account for variation in a response. Factors are 
the variables whose values (levels) you set to study their relationship to a 
response. You often experiment with many potentially influential factors at 
the same time.

False Discovery 
Rate

The expected percentage of a set of predictions that are assumed to be false. 
For example, if an analysis which predicts the association of 10 genes with 
a particular trait has a false discovery rate of 0.1, you can expect 9 of the 
predictions to be correct.

Field A window area in which you can view, enter, or modify a value

Fixed Effects The effects that drive the variation that you are interested in assessing that 
have a fixed number of well-defined levels. They can also include nuisance 
variables that you need to consider in your model. Fixed effects include fac-
tors such as experimental treatment, disease status, age/developmental sta-
tus of the test organisms, gender. Variation due to fixed effects is the 
variation you are interested in estimating and must be kept in the analysis. 

Genotype The genetic compliment an individual possesses at a particular locus.

Group Variable A variable that is used for grouping results.

Haplotype The combination of alleles that is transmitted from one generation to the 
next as a single unit on a chromosome.

Hardy-Weinberg 
Equilibrium

The state of a population in which gene frequencies and genotypic ratios 
remain constant from generation to generation.

Heat Map See Cell Plot.

Hold-out Data A portion of the data that is set aside during model development. Hold-out 
data can be used as test data to benchmark the fit and accuracy of the 
emerging predictive model.
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Hoeffding Correla-
tion (D)

A nonparametric measure of association that detects general departures 
from independence. This statistic approximates a weighted sum over obser-
vations of chi-square statistics for two-by-two classification tables.

Imputation The computation of replacement values for missing input values.

Inbreeding Coeffi-
cient

The probability that an individual's two alleles at any locus are identical by 
descent.

Independent Vari-
able

This variable does not depend on the value of another variable; it repre-
sents the condition or parameter that is manipulated by the investigator. In 
a two-dimensional plot, the independent variable is usually plotted on the 
x (horizontal) axis.

Index Variable One or more columns specifying how the observations are to be classified.

Interval Mapping 
(IM)

Method for mapping of a target QTL for a trait between two flanking 
markers.

Jitter A random shifting of points by a slight amount along an axis so that more 
of those points can be effectively visualized in a graphical display.

K_Rho The information for the LD measure Rho.

Kendall Correlation A metric used to measure the degree of correspondence between two sets of 
rankings where the metrics used to assess each set of rankings are not 
equivalent.

Kinship (Coances-
try) Coefficient

The probability that two alleles from a single locus in a randomly selected 
pair of individuals are identical by descent.

K-Means A statistical method that creates optimally-separated groups of observations 
of a data using one of several methods. A set of points called cluster seeds is 
selected as a first guess of the means of the clusters. One cluster seed is 
selected for each of k clusters. Each observation is assigned to the nearest 
seed to form temporary clusters. The seeds are then replaced by the means 
of the temporary clusters, and the process is repeated until no further 
changes occur in the clusters.

Label Variable A column containing descriptive labels of up to 40 characters that can be 
printed in the output by certain procedures instead of, or in addition to, 
the variable name.

Leaf In a tree map, a leaf is any segment that is not further segmented. The final 
leaves in a tree are called terminal nodes.
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Level A successive hierarchical partition of data in a tree map. The first level rep-
resents the entire unpartitioned data set. The second level represents the 
first partition of the data into segments, and so on.

Linkage The property by which alleles located on the same chromosome tend to be 
inherited together. The closer two loci are on the chromosome, the more 
tightly they tend to be linked.

Linkage Disequilib-
rium (LD)

A measure of the association between two alleles at separate loci. 

Note: A high LD does not imply that loci are physically linked. 

An association (either positive or negative) between alleles can occur even if 
the loci are not located on the same chromosome, provided other factors 
affecting the population (directional selection, for example) are in effect.

Lod Score A logarithmic statistical estimate of the probability that two loci are located 
proximal to each other on a chromosome. A Lod score of 3, which indicates 
that two loci are 1000 times more likely than not to lie close to each other, 
is generally considered minimal for significance.

Loess Normaliza-
tion

Method for eliminating non-biological bias and variation from microarray 
data by fitting a local regression curve to expression data. Method assumes 
that the majority of the genes in the study are not differentially affected by 
the experimental conditions.

Loss of Heterozy-
gousity (LOH)

Results from a deletion (or other mutation) of the normal allele, at a locus 
heterozygous for the normal allele and a deleterious mutant allele. Produces 
a locus that is either homozygous or hemizygous for the deleterious allele.

LSMeans Least squares means, which are estimates of means of classification effects 
that would be observed if the experimental design is balanced. 

Main Effect An effect measures the extent to which the response depends on the factors 
involved in the effect. A main effect is the change in the response due to a 
single factor. For two-level factors, the main effect is the difference between 
the mean response at the high level of a factor and the mean response at its 
low level. 

Marker Variable The column listing each individual's allele or genotype for the genetic 
markers used in an analysis. If marker variables are listed as alleles, there is a 
pair of marker variables for each marker.

Mean Mathematical average for a collection of n observations. It is calculated by 
dividing the sum of the observations by n.
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Median In any set of n observations arranged in order of magnitude, the median is 
represented by the observation positioned at n/2.

Menu Bar The primary list of items at the top of a window which represent the 
actions or classes of actions that can be executed. Selecting an item executes 
an action, opens a pull-down menu, or opens a dialog box that requests 
additional information.

Missing Value A value in the SAS System indicating that no data is stored for the variable 
in the current observation. It is indicated by a single dot (.) for a numeric 
variable or a blank for a character variable.

Mixed Model A statistical model containing both fixed and random effects.

Model A formula or algorithm that computes output values from input values.

Monophyletic Describes any group descended from a common ancestor that includes the 
ancestor and all of its descendents.

Nominal Variable A variable that contains discrete values that do not have a logical order. 
Includes names and other verbal descriptions.

Numeric Variable A variable that contains only numeric values and related symbols, such as 
decimal points, plus signs, and minus signs.

Observation A row (horizontal component) in a SAS data set. Each observation con-
tains one data value for each variable in the data set.

Ordinal Variable A variable that contains discrete values that have a logical order. For exam-
ple, a variable called Rank could have values such as 1, 2, 3, 4, and 5.

Overfit To train a model to the random variation in the sample data. Overfit mod-
els contain too many parameters (weights), and they do not generalize well

PCTL Percentile.

Partial Least 
Squares (PLS) 
Coefficient

A statistical technique that simultaneously partitions variability of both X 
and Y variables, somewhat similar to principal components.

Pearson Correla-
tion

A statistical measure of the linear relationship between two variables. It is 
reported as some value between +1 and -1. A value of +1 indicates a per-
fect, direct, correlation between the variables; a value of -1 indicates a per-
fect, inverse, correlation between the variables.

Pedigree The ancestral lineage of an individual or group of closely related individu-
als
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Phenotype The physical manifestation of a genotype.

Population Stratifi-
cation

The phenomenon in which differences in allele frequencies between cases 
and controls in studies of genetic diseases that might have been ascribed to 
association of specific genes with disease are instead found to result from 
systematic differences in ancestry of the experimental groups.

Power The probability of a statistical significance test allowing you to reject the 
null hypothesis when the alternative hypothesis is true.

Predictor A function or variable used to estimate a response.

Predictor Class 
Variable

An independent variable used to predict a dependent variable. Its distinct 
levels correspond to different predictions, and are often modeled by con-
structing a set of 0-1 binary variables corresponding to each distinct level.

Predictor Continu-
ous Variable

A numeric independent variable that predicts a dependent variable. Its pre-
dictions are computed directly as a function of the numeric variable, as in a 
linear regression.

Predictive Model A statistical tool, made up of informative variables, that is used to forecast 
future behaviors or responses. 

Principal Compo-
nents

Linear combinations of all of the original variables that maximally explain 
variability. Useful when the analysis considers effects of many variables at 
once. By combining the variables into groups, you can reduce the total 
number in any one analysis. 

Probe Intensity Strength of the signal generated by hybridization of the target sequence to 
the specific probe set on the microarray.

Probe Set All of the different probes specific for a transcript. As an internal control, 
microarrays typically include multiple target sequences taken from differ-
ent regions of a transcript. Comparisons of intensities resulting from the 
hybridization of transcripts to each of these sequences allows for more 
effective evaluation of transcript levels. The collection of targets specific for 
a transcript are referred to as a probe set.

PROC A SAS procedure; a group of SAS statements that call and execute a proce-
dure, usually with a SAS data set as input

Pull-down Menu The list of menu items or choices that appears when you choose an item 
from a menu bar or from another menu.

p-Value The statistical probability that a statistic is as or more extreme than the 
observed value, assuming the null hypothesis is true. A smaller p-value 
allows you to more rigorously reject the null hypothesis.
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Quantile Portions taken at regular intervals along a distribution that divide a data set 
into discrete subsets.

Quantitative Trait 
Locus (QTL)

A region of DNA that is associated with the strength of a particular pheno-
type. By themselves, QTLs do not determine whether or not a gene is 
expressed. Instead, each QTL interacts with other QTLs, located through-
out the genome, to influence the relative level of expression.

Random Effects The effects that cause extraneous variation in your results and have little to 
do with the questions being addresses. Random effects include factors such 
as physical differences between the arrays, or batch effects resulting from 
performing different parts of the experiments at different times, on differ-
ent days, using different lots of reagents, etc. Variation resulting from ran-
dom effects can confound your results and should be eliminated from your 
analysis. 

Random Number 
Seed

The starting point for a random number generator. Unless a number is 
specified, an arbitrary value, such as the date/time of an event, is used.

Residuals Values equal to the response values minus the predicted values.

Rho See Spearman Correlation. Also, a measure of linkage disequilibrium.

Root Mean Square 
Error (RMSE)

A measure of the differences between the values predicted by a model or an 
estimator and the values actually observed. It is calculated by taking the 
square root of the mean square error value.

SAS Data Set A file whose contents are in one of the native SAS file formats. SAS data 
sets contain data values in addition to descriptor information that is associ-
ated with the data. 

SAS Log A file that contains all the SAS statements you have submitted, messages 
about the execution of your analytical process and the SAS program run-
ning in the background, and in some cases, output from certain proce-
dures. This file is generated and placed in the designated output folder.

Single Nucleotide 
Polymorphism 
(SNP)

DNA variant in which a sequence differs from the wild-type or other refer-
ence sequence by a single nucleotide.

Smoothing Band-
width

 A number determining the degree of smoothing for certain algorithms.

Spearman Correla-
tion

Non-parametric method for examining whether two quantitative variables 
co-vary. Each pair of variables are converted to ranks and are linked with an 
“unseen” nominal variable.
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Standard Deviation A statistical measure of how “spread out” the data are. It is calculated by 
taking the positive square root of the sum of the squared deviations of each 
observation from the sample mean divided by (n-1).

Standard Error The standard deviation of the sample mean. It is calculated by dividing the 
standard deviation by the square root of the sample size.

Strata Variable A variable that partitions the data into blocks with similar characteristics.

Tau Value A nonparametric measure of association based on the number of concor-
dances and discordances in paired observations. Concordance occurs when 
paired observations vary together, and discordance occurs when paired 
observations vary differently. Also, used for the truncated product p-value 
adjustment method to indicate that there is at least one false null hypothe-
sis among those with p-values less than Tau when the null hypothesis is 
rejected.

Test Data Set See Hold-out Data.

t-statistic A measure of how extreme a statistical estimate is. It is calculated by sub-
tracting a reference of hypothetical value from your estimate and then 
dividing the remainder by the standard error value for the experiment. 

t-test A test that assesses the statistical difference between the means of two dif-
ferent experimental groups.

Transmission Dise-
quilibrium Test 
(TDT)

A family-based association test used to map binary traits.

Training Data Set The portion of the initial data set that contains input values and target val-
ues that are used to develop a predictive model.

Transcript Cluster A consensus sequence of nucleotide bases made up of the cluster of exons 
transcribed from a particular strand of a defined region of the genome.

Transformation The process of applying a function to a variable in order to adjust the vari-
able's range, variability, or both

Tree The complete set of rules that are used to split data into a hierarchy of suc-
cessive segments. A tree consists of branches and leaves, in which each set 
of leaves represents an optimal segmentation of the branches above them 
according to a statistical measure.

Variable A column (vertical component) in a SAS data set. The data values for each 
variable describe a single characteristic for all observations

Definitions/Explanations of Terms Used in JMP Genomics Documentation

Term Definition/Explanation



108 Glossary Chapter 10

Variance A measure of deviation of a group of samples from the mean. It is calcu-
lated by squaring the standard deviation.

Venn Diagram A graphical representation composed of two or more overlapping circles 
that shows all of the hypothetical relationships between two or more data 
sets.

Volcano Plot A scatter-plot of the negative log10-transformed p-values derived from 
gene-specific t test against the log2-fold change in expression. Genes whose 
expression is decreased lie to the left of the mean; genes whose expression is 
increased lie to the right of the mean. Genes with statistically significant 
differential expression lie above a horizontal threshold. This plot provides 
an effective means for visualizing the direction, magnitude, and signifi-
cance of changes in gene expression.

Where Clause A SAS statement that allows you to filter a set of observations so that only 
the subset of data meeting the specific filtering criteria are considered in 
the analysis.

Wizard An interactive utility program that consists of a series of dialog boxes, win-
dows, or pages. You supply information in each dialog box, window, or 
page, and the wizard uses that information to perform a task. 
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